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��	 �����
This Codebook and Users’ Guide provides a tool for programmers and analysts to assist them in 
creating cross-tabulations and basic statistical estimates from the 2007 Adult Health Care Survey of 
DoD Beneficiaries (HCSDB). It is intended to assist users in creating tables and generating analyses 
above and beyond those associated with this project. 

Beginning with 2006, reporting and documentation of the HCSDB will be performed on a fiscal year 
basis.  In previous years, reporting and documentation were based on calendar years.  Thus the 
current codebook describes Quarter II of fiscal year 2007.  Throughout, Quarter II refers to Quarter II of 
fiscal year 2007. 

This version of the Codebook and User’s Guide describes the second quarter data set.  It contains 
frequency counts of all variables from the second quarter of fiscal year 2007.   

This chapter explains how to use this guide, reviews the survey, briefly describes the sample design, 
and concludes with a list of other documents on the HCSDB data that may be useful for policymakers, 
administrators, and other users.  

����	�������
���������

Chapter 2 describes the survey fielding process.  

Chapter 3 describes the database conventions and types of variables in the database. Furthermore, it 
explains the relationship between the raw survey data and the cleaned and constructed variables 
preferred for data analyses.  

Chapter 4 provides table-making instructions in both SAS and SPSS and clearly demonstrates the 
basic computer programming code necessary to tabulate the data in SAS and the interactive steps 
involved in generating tables in SPSS (either statistical package may be used). While we assume that 
most users have some knowledge of computer systems and statistical processing, examples of how to 
create tables and the resulting output are provided in order to simplify the process of data tabulation. 
Due to the complexity of the sample design, we suggest that users interested in measuring the 
precision of their results use a statistical package capable of calculating standard errors for survey 
estimates, such as SUDAANTM or WesVar PC®. Sample programming code is included to estimate 
standard errors using appropriate methods to accommodate the complex sample design.  

The codebook is presented in Chapter 5, where we describe the quarterly counts for each variable in 
the database, including a list of all possible values of the variable, weighted and unweighted frequency 
counts and percent occurrences for each value, and the values’ interpretation or formatting. The 
codebook helps users assess the availability of certain measures, specify variables of interest, and 
identify all possible values of a variable. The variables are listed in the order of their position on the data 
file, and they are grouped by source as follows: 

�� Sampling variables used to place beneficiaries in the appropriate strata 

�� Information from the Defense Enrollment Eligibility Reporting System (DEERS) at the time of 
sampling 

Chapter 

%
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�� Questionnaire responses:  cleaned and recoded 

�� Variables created during the fielding of the survey 

�� Coding Scheme flags and missing value counts 

�� Constructed variables for analysis 

�� Weights 

In addition, users may refer to the Table of Variables, which follows directly after the Table of Contents, 
for an alphabetical quick-reference list intended to assist users in locating each variable. 

Users interested in learning more about the technical aspects of the database creation, construction of 
new variables, or MPR’s report production procedures may refer to “The 2007 Health Care Survey of 
DoD Beneficiaries: Adult Technical Manual,” available from the TRICARE Management Activity Office. 

&�����������'��()*�

The HCSDB is a health care survey of active duty military personnel, retirees, and their adult family 
members.  It is comprised of an adult and a child survey, both fielded to a representative sample of 
beneficiaries.  The adult survey is fielded every quarter, whereas the child survey is fielded only in the 
third quarter of each fiscal year.  Results from each quarter are presented as a web-based report.  The 
survey is sponsored by the Assistant Secretary of Defense (Health Affairs) [OASD (HA)], under 
authority of the National Defense Authorization Act for Fiscal Year 1993 (P.L. 102-484). The surveys 
collect data on beneficiaries’ satisfaction with, and access to, health care; knowledge of the TRICARE 
system; and use of preventive and other health care services.  

Fielded annually from 1994 to 2000, the HCSDB now is fielded quarterly and consists of a fixed core 
questionnaire complemented by quarterly supplements intended to address topics of emerging interest. 
Users should note that, prior to 2000, the title of the HCSDB corresponded to the reference year that 
respondents were asked to think about when responding to questions.  For example, although the 
2000 HCSDB was fielded in 2001, beneficiaries responded to questions according to the reference 
period 12 months prior.  Under the current naming convention the survey title refers to the year the 
questionnaires are fielded, so, for example, this year's survey is the 2007 HSCDB.  Users should 
further note that, due to this change, there is no survey with the title "2001" survey, even though the 
questionnaire has been administered continuously throughout each quarter of 2001, 2002, 2003, 2004, 
2005, 2006, and 2007.  The annotated questionnaire appears in Appendix A.  A crosswalk between the 
2007 questions and the questions from the 1997, 1998, 1999, 2000, 2002, 2003, 2004, 2005 and 2006 
surveys appears as Appendix C.  

The HCSDB fixed questionnaire covers the following topics: 

�� Health Plan. This section collects data on TRICARE Prime enrollment and the use of 
supplemental insurance and/or other private insurance.  

�� Your Personal Doctor or Nurse. In this section, respondents are asked about their relationship 
with their personal doctor or nurse. They are asked to rate their personal doctor or nurse on a 
scale from 0 to 10, where 0 is the lowest rating and 10 is the highest rating.  

�� Getting Health Care from a Specialist. This section collects information about respondents’ 
need for and access to care from specialists. Respondents rate the specialist that they see most 
frequently on a scale from 0 to 10, where 0 is the lowest rating and 10 is the highest rating. 

�� Calling Doctors’ Offices. Questions in this section ask beneficiaries whether they were able to 
access care and obtain information by telephone from their doctor’s office or clinic. 
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�� Your Health Care in the Last 12 Months.  This section collects information on where DoD 
beneficiaries received the majority of their care in the past 12 months, that is, from a military or 
civilian facility. It also covers topics such as the availability of providers and their staff, convenience, 
and courtesy and respect shown by providers and their staff.  

�� Your Health Plan. This section is designed to measure beneficiaries’ satisfaction with their 
primary health plan. Respondents are asked to rate their health plan on a scale of 0 to 10 where 0 
is the lowest rating and 10 is the highest rating.  Additionally, respondents are asked questions 
about any problems they may have encountered with claims processing, accessing and 
comprehending written materials, customer service, and processing paperwork.  

�� Your Preventive Health Care.  This section collects information on the use of preventive health 
care services, including blood pressure readings and flu shots.  All women are asked about Pap 
smears; women that are or have been pregnant within the past 12 months are questioned about 
prenatal care.  Women age 40 and over are asked about mammography.  All respondents are 
asked whether they smoke.  Smokers are asked whether, and how often, they have received 
smoking cessation counseling from a health care professional.  

�� About You.  This section asks basic background and health status questions.  Beneficiaries are 
asked how they view their general health.  They are further asked to report their height, weight, 
education level, race, and age.     

��'����	��������

To make responses comparable to civilian surveys, the questions are similar in content and format to 
questions used in the Consumer Assessment of Healthcare Providers and Systems (CAHPS) 
Health Plan Survey. CAHPS is a survey program sponsored by the Agency for Health Care Research 
and Quality, U.S. Department of Health and Human Service, and the Picker Institute, which is designed 
to monitor beneficiaries’ satisfaction with their civilian health care plan and access to health care 
services.  In 2007 we used questions from CAHPS version 3.0.   

�	�
��
�

��	����+�����

�� TRICARE Reserve Select.  These supplemental questions concern health care coverage 
provided to qualified members of the Selected Reserve. 

�� Reservists.  These supplemental questions concern health care coverage provided to National 
Guard and Reserves and members of their immediate families. 

��+����(������,��
���-�

The sample of beneficiaries for the HCSDB was drawn from an extract file of the DEERS database of 
military health system (MHS) beneficiaries with a specific reference date.  The DEERS extract file 
includes all eligible MHS beneficiaries as follows: 

�� Everyone in the Uniformed Services and on active duty (Army, Air Force, Navy, Marine Corps, 
Coast Guard, the Commissioned Corps of the Public Health Service, National Oceanic and 
Atmospheric Administration, Guard/Reserve personnel who are activated for a period in excess of 
30 days, and other special categories of people who qualify for benefits)  

�� Those who retired from military careers 

�� Immediate family members of people in the previous two categories 

�� Surviving family members. 
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A stratified sample design was used to select DoD health care beneficiaries for Quarter II, 2007 Adult 
HCSDB.  Specific information on the sample design appears in “Health Care Survey of DoD 
Beneficiaries: 2007 Adult Sampling Report”, Mathematica Policy Research, Washington, D.C. 

From a sample of 50,000 beneficiaries, 12,892 adult MHS beneficiaries completed and returned a 
2007 Adult HCSDB questionnaire for the second quarter during the period, yielding a response rate of 
26.1 percent.  Information on developing response rates can be found in the "2007 Health Care Survey 
of DoD Beneficiaries: Adult Technical Manual." 

 

,���
�(� 	+�����������������'��()�

This document is intended for programmers and analysts using the 2007 Adult HCSDB data. The 
following is a list of other documents that may be requested from the TRICARE Management Activity 
Office: 

�� Health Care Survey of DoD Beneficiaries:  2007 Adult Sampling Report 

�� 2007 Health Care Survey of DoD Beneficiaries:  Adult Technical Manual  

�� 2007 Health Care Survey of DoD Beneficiaries:  TRICARE Annual Report  



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES –QUARTER II 
 

05/24/07  5 

 
 

�	
�����#���	����
This chapter presents information on the survey administration cycle for Quarter II, 2007 Adult Health 
Care Survey of DoD Beneficiaries (HCSDB), with specific details on the survey mailing cycle and the 
number of surveys received.  

� � 
������!"���	�������	���	����

Operational support for the Health Care Survey of DoD Beneficiaries (HCSDB) involved four mailings 
to beneficiaries between December 2, 2006 to February 7, 2006 in Quarter II.   

The mailings include: 

1. Pre-Notification Letter – Letter of explanation encouraging participation  
2. Questionnaire 1 – The survey, including a brief letter of explanation 
3. Postcard – A reminder to complete the survey and a thank you for completion 
4. Questionnaire 2 – The survey, including a brief letter of explanation 
 
Starting this quarter, the letter of explanation that accompanied the survey was eliminated.  Instead, 
information about the survey and contact phone numbers and email addresses were included on the 
front cover of the survey.  The survey was inkjetted to include the Beneficiaries’ unique internet 
password if they wanted to do the survey online instead of mailing back the survey. 

).� 
�#"���

The Adult HCSDB is conducted quarterly on a sample of 50,000 beneficiaries.   

�.� �/0$12��0,�1��
34��

Synovate applies a Bar Code, Control Number (MIQ) & Password to each beneficiary upon receipt of 
the sample.  This system ensures that all data collected is aggregated and available throughout the 
survey lifecycle.  Each of the identifying labels is detailed below: 

Barcode 
Digit 1 - Quarter Marker (1-4) 
Digit 2 - Wave Marker (1-4)  
Digit 3 - Study Marker (1=sample, 2=supplemental, 3=child)  
Digits 4-8 - Sequential ID#  
 
Control Number (MIQ) - 8-digit unique identifier  
Digits 1-7 – Sequential ID # 
Digit 8 – Check Digit  
 

Chapter 

�
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Password 
Non-sequential 6-digit password (for online response access) – Password is unique across all 
samples 
 

� � ����������

The HCSDB is designed so that beneficiaries may receive up to four mailings.  Synovate may collect 
up to eight addresses for each beneficiary in order to maximize the receipt rate for mailing. 

The first available address in the following order was used for each mailing.  

1. Respondent Updated 
2. Updated Residential 
3. NCOA 
4. Original Residential 
5. Updated Sponsor 
6. Original Sponsor 
7. Updated Unit 
8. Original Unit 

 
The origin of the addresses is as follows: 

�� Altarum - DEERS Addresses 

In the initial sample file, Altarum provides up to three addresses for each beneficiary.  Synovate 
considers these addresses to be Original Residential, Original Sponsor and Original Unit. 

Altarum also provides updates on each of the three addresses prior to the Questionnaire, Postcard 
and 2nd Questionnaire mailings.  Synovate records these addresses as Updated Residential, 
Updated Sponsor, Updated Unit. 

�� NCOA Address 

Upon receipt of the initial sample and prior to the Pre-Notification mailing, Synovate sends the first 
available address for each beneficiary to a National Change of Address (NCOA) vendor for 
updating and hygiene services.   The updated address returned by the vendor is marked as the 
NCOA address. 

�� Respondent Updates 

Respondents were able to report address and status changes via telephone, voicemail, fax, and 
email.  Addresses changes submitted by respondent were considered priority over any other 
address type. 

�� Address correction via USPS 

The United States Postal Service provided address corrections on returned mail if available.  This 
is marked as a respondent updated. 

Tables 2.1 gives the address breakdown for each mailing by beneficiary category. 

�
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Quarter II 
File Receipt 11/21/05 

NCOA Update 11/22/05 

Pre-Notification 12/2/05 

STI-DEERS Update 12/15/05 

Questionnaire 1 1/4/06 

Postcard 1/13/06 

STI-DEERS Update 1/19/06 

Questionnaire 2 2/1/06 

Close of Field 3/1/06 

File to MPR 3/16/06 

Final Report to DoD 3/20/06 

�
 

��� �
����
�
���������

Synovate assigns disposition codes to each sample member as the information is received and 
questionnaire is returned. These codes are outlined below. 

• FLAG_FIN=1 
Returned survey – survey was completed and returned. 

• FLAG_FIN=2  
Returned ineligible – survey was returned with at least one question marked and information that 
the beneficiary was ineligible.  The information indicating ineligibility may have come by mail, 
phone, fax, or the survey itself. 

• FLAG_FIN=3 
Returned blank – temporarily ill or incapacitated.  Survey was returned blank along with information 
that the beneficiary was temporarily ill or incapacitated.  These sample members were eligible.  

• FLAG_FIN=4 
Returned blank – deceased.  Survey was returned blank along with information that the beneficiary 
was deceased.  These sample members were ineligible. 

• FLAG_FIN=5 
Returned blank – incarcerated or permanently incapacitated.  Survey was returned blank along 
with information that the beneficiary was incarcerated or permanently hospitalized.  These sample 
members were ineligible. 

• FLAG_FIN=6 
Returned blank – left military or divorced after the fielding date, retired.  Survey was returned blank 
along with information that the beneficiary left the military after the fielding date, divorced after the 
fielding date, or retired.  These sample members were eligible. 
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• FLAG_FIN=7 
Returned blank – not eligible on the fielding date.  Survey was returned blank along with 
information that the beneficiary was not eligible for Military Health System Plan on the fielding date. 
 These sample members were ineligible. 

• FLAG_FIN=8 
Returned blank – other eligible.  Survey was returned blank along with a reason given by the 
sample member.   These sample members were eligible. 

• FLAG_FIN=9 
Returned blank – no reason.  Survey was returned blank without an explanation.  These sample 
members were eligible. 

• FLAG_FIN=10 
No return – temporarily ill or incapacitated.  Survey was not returned and beneficiary was 
temporarily ill or incapacitated.  These sample members were eligible. 

• FLAG_FIN=11 
No return – active refuser.  Survey was not returned and beneficiary refused to take part in the 
survey.  These sample members were eligible. 

• FLAG_FIN=12 
No return – deceased.  Survey was not returned and beneficiary deceased.  These sample 
members were ineligible.  

• FLAG_FIN=13 
No return – incarcerated or permanently incapacitated.  Survey was not returned, beneficiary was 
incarcerated or permanently hospitalized.  These sample members were ineligible. 

• FLAG_FIN=14 
No return – left military or divorced after the fielding date, retired.  Survey was not returned, 
beneficiary left service after the fielding date, divorced after the fielding date, or retired.  These 
sample members were eligible. 

• FLAG_FIN=15 
No return – not eligible on the fielding date.  Survey was not returned, beneficiary was not eligible 
for Military Health System Plan on the fielding date.  These sample members were ineligible. 

Example:  Beneficiary turned 21 and is no longer covered under parents’ plan. 

• FLAG_FIN=16 
No return – other eligible.  Survey was not returned, beneficiary gave other reason for not 
completing the survey.  These sample members were eligible. 

Examples:  Beneficiary claims they have not used benefits in past 12 months. 

Beneficiary is away at college, on a religious mission, lives overseas. 

Received information that Beneficiary chosen for survey does not speak English well enough to 
participate. 

• FLAG_FIN=17 
No return – no reason.  Survey was not returned, beneficiary gave no reason. 
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• FLAG_FIN=18 
PND – no address remaining.  All addresses were attempted, mailing was returned PND. 

• FLAG_FIN=19 
PND – address remaining at the close of field.  At the close of field, the last address used was 
found invalid, next available was not attempted. 

• FLAG_FIN=20 
Original Non-Locatable – no address at start of mailing.  Substantially incomplete or blank address 
field before the survey was administered, no mailings attempted. 

• FLAG_FIN=21 
Beneficiary provides written documentation declining to participate but doesn’t specify a reason. 

• FLAG_FIN=22 
Beneficiary indicates they are hospitalized but without providing any way to determine whether 
incapacity is temporary or permanent.  Therefore, eligibility determination can not be made.  

• FLAG_FIN=23 
Returned blank – deployed.  Survey was returned blank along with information that the beneficiary 
was deployed.   

• FLAG_FIN=24 
No return – deployed.  Survey was not returned, beneficiary was deployed.   

• FLAG_FIN=25 
Beneficiary coded as deceased due to refresh. 

• FLAG_FIN=26 
No match.  Missing address after refresh, otherwise ineligible. 

Tables 2.2 shows frequencies of these disposition codes by beneficiary category. 
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This chapter presents the procedures for developing the database, and presents the database file 
layout.  

���������	�
����
�����������

The conventions used to name variables on the 2007 Adult HCSDB data file are listed below and 
summarized in Table 3.1.  The naming conventions remain constant across the four quarters of the 
2007 HCSDB. 

�� Survey Variables. Variable names for core survey questions consist of up to eight alphanumeric 
characters that start with an alpha character ("H" for Adult survey variables), followed by a year 
designation (“07”) and ending with three numbers and, if necessary, one alpha character to identify 
the relevant survey question.  Recoded variables have the same names as on the annotated 
survey.  The original variables are suffixed with “_O”; these will not be on the public release file. 

�� Supplemental Question Variables. Each quarter, the questionnaire includes a battery of 
questions on specific health care topics concerning services offered to MHS beneficiaries.  Like 
the core questions, supplemental questions also include eight alphanumeric characters; each 
variable begins with an “S” to distinguish it as a supplemental question, followed by the year 
designation (“07”).  The variable ends with an alpha character denoting the supplemental topic 
followed by the question number in the supplemental series.   

�� Self-Reported Data. Defense Manpower Data Center (DMDC) standard demographic self-
reporting variables on the adult survey are prefixed with “SR.”  Survey variables with this naming 
convention include SRRACEA-SRRACEE (race/ethnicity) and SREDA (education). 

�� Coding Scheme Flags and Counts. Coding Scheme flags, variables N1-N19, reference the 
notes in the Coding Scheme for Adult Survey.  See Appendix D for the Coding Scheme for 
Quarter II for more information. Coding Scheme counts are sums of missing value responses for 
each questionnaire; each of these variable names begins with the 4 characters “MISS”. 

�� Constructed Independent Variables. Independent variables are prefixed with an "X."  These 
include original survey variables modified as a result of data cleaning or recoding and newly 
constructed variables that did not previously exist on the survey file. For example, since the 
variable PNSEXCD was modified as a result of data cleaning and recoding, it was renamed 
XSEXA. 

�� Constructed Dependent Variables. Dependent variables are given different prefixes depending 
on function. Healthy People 2010 variables, for example, are prefixed with an "HP” and all other 
newly constructed dependent variables are prefixed with a "K." 

�� Weighting Variables. Quarterly weighting variables are prefixed with a "FW."  

Chapter 

�
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TABLE 3.1 
 

NAMING CONVENTIONS FOR 2007 HCSDB VARIABLES – QUARTER II 

 
1st Character: 
Survey Type 

 
2nd – 3rd 

Character
s: 

Survey 
Year 

 
4th – 6th Characters: 

Question # 

 
Additional Characters: 
Additional Information 

 
 
H= Health 
Beneficiaries (18 and 
older, Adult 
Questionnaire) 
 
 
 
 
 
---------------------------------- 
S = Supplemental 

Question 

 
 

07 

 
 

001 to 070 
 
 
 
 
 
 
 
 

---------------------------------- 
Quarter II 
001-008 – Supplemental questions about 
TRICARE reserve select. 
G18-G39 – Supplemental questions about 
research coverage. 
 
 

 
 
A to R are used to 
label responses 
associated with a 
multiple response 
question 
 
_O denotes an 
original version of a 
recoded variable 
------------------------------ 
 

 
 
 
1st Characters: 
Variable Group 

 
Additional Characters: 
Additional Information 

 
SR=Self-reported demographic data 

 
Descriptive text, e.g., SREDA 

 
N=Coding scheme notes 

 
Number referring to Note, e.g., N2 

 
X=Constructed independent variable 

 
Descriptive text, e.g., XREGION 

 
HP=Constructed Healthy People 
2010 variable 

 
Descriptive text, e.g., HP_BP (had blood pressure 
screening in past two years and know the results) 

 
K=Constructed dependent variables 

 
Descriptive text, e.g., KMILOPQY (total number of 
outpatient visits to military facility) 

FW=Quarterly Weighting variables Descriptive text, e.g., FWRWT for the final quarterly 
weight and number referring to replicate weights, e.g., 
FWRWT10 

 

����
�
���
�������
���	
��
��	
��

Data quality procedures are found in the Coding Scheme tables. The complete Coding Scheme for 
Quarter II appears in Appendix D. It contains detailed instructions for all editing procedures used to 
correct data inconsistencies and errors. Editing procedures check for appropriate response values and 
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consistent responses throughout the quarterly questionnaire. The steps to insure data quality include 
the following: 

�� Initial Cleaning. Missing value flags were encoded when Synovate created the SAS dataset: 

- Skipped items were encoded with SAS missing value code of ‘.’. 

�� Data Cleaning and Recoding of Variables – Implementation of the Coding Scheme. Skip 
patterns were checked for consistency, and questions that were skipped legitimately were recoded 
with the SAS missing value of “.N”; questions that were answered, but should have been skipped, 
were recoded with a SAS missing value of “.C”. When possible, variables were backward coded or 
forward coded to make all responses consistent within a sequence. Numeric values were 
checked, and values that were out of range were flagged with the SAS missing value of “.O”. 

�� Frequency Checks. Formatted and unformatted frequency tables for all variables in Quarter II of 
fiscal year 2007 Adult HCSDB data file appear in Chapter 5 of this document. These frequency 
tables and other relevant cross tabulations were used to examine the range of values recorded for 
each data item to determine the type and magnitude of missing values. All value labels have been 
checked for accuracy. 

�����������������
��������

Blank returns, nonrespondents, and any respondents found to be ineligible for MHS benefits were 
removed from the database. In addition, among eligible respondents with a non-blank questionnaire, a 
questionnaire must be “complete” to be included in the database.  

To determine if a questionnaire is “complete”, 27 key questions were chosen.  These key questions 
were adapted from the complete questionnaire rule developed by AHRQ for CAHPS surveys. At least 
50 percent of these key items (more than thirteen) must be answered for a questionnaire to be 
accepted as a complete questionnaire.  The key survey variables are:  H07006, H07008, H07009, 
H07010, H07011, H07012, H07014, H07015, H07016, H07017, H07018, H07019, H07021, H07024, 
H07025, H07027, H07030, H07037, H07038, H07042, H07044, H07046, H07048, H07066, SREDA, 
H07070, and the race indicator. 

����
��
����	��������

The analysis of survey data from complex sample designs, such as the 2007 Adult HCSDB, requires 
weights to do the following: 

�� Compensate for variable probabilities of selection 

�� Adjust for differential response rates 

�� Improve the precision of the survey-based estimates through post-stratification [for details, see 
Brick and Kalton (1996) and references cited therein]. 

Sampling weights are equivalent to the reciprocal of the probability of each respondent’s selection into 
the sample. Sampling weights are further adjusted for nonresponse within the classes formed based 
on the percentiles of the propensity scores from the propensity model.  Finally, we poststratified the 
nonresponse adjusted weights to the frame totals to obtain specific domain weighted totals equal to the 
population totals. Chapter 5 contains the weighted and unweighted frequencies for each variable in 
Quarter II. For further details of the 2007 weighting, see Health Care Survey of DoD Beneficiaries:  
2007 Technical manual. (2007). 
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��	������
��������
This chapter is designed to help users create tables and variance estimates. Procedures for using 
SAS, SPSS, SUDAAN, and WesVarPC to create estimates are explained. Examples provided in the 
text are based on the 2007 Quarter II HCSDB dataset. 

������������������������������

The Quarter II, 2007 Adult HCSDB dataset is provided in a Statistical Analysis System (SAS) 6.0 
format. SAS is a computer software system used for data management, summarization, and analysis.  
Later versions of SAS can also read version 6 datasets.  A format library for the adult database is 
included along with the dataset. SAS can be run interactively or non-interactively (in batch mode), and 
the sample programs presented here can be run using either method. Special instructions are given 
later in the chapter for working interactively with the SAS Display Manager System in a Windows 
environment. All SAS programs generate a LOG and a LST file. The LOG file shows how SAS 
interprets your program and flags SAS syntax errors. The LST file shows the requested output. 

 ����!�����
���"�#��������"��
��$���	
��

SAS recognizes two types of datasets -- permanent and temporary. Permanent datasets, such as the 
HCSDB, are located through a LIBNAME that references the directory where the data is stored. For 
example, if the 2007 Quarter II adult dataset is located on a CD-ROM in the subdirectory 
HCSDB07\FORMA\Q2, your LIBNAME statement must look like this: 

LIBNAME INFORMA ’F:\HCSDB07\FORMA\Q2’; 
 
The adult dataset can then be referred to as INFORMA.HCSDB07, where INFORMA is the location of 
the file HCSDB07. 

A format library requires a LIBNAME LIBRARY statement that shows the location of the format library. 
For example, if the adult format library is stored on your hard drive in a FMTLIB subdirectory, the 
LIBNAME statement should look like this: 

LIBNAME LIBRARY 'C:\HCSDB07\FORMA\Q2\FMTLIB'; 
 

The OPTIONS statement controls page format and line length. A table with a “portrait” orientation might 
have this statement: 

OPTIONS PS=79 LS=132; 
 

A table with a “landscape” orientation that is left justified would have this OPTIONS statement: 

OPTIONS PS=50 LS=175 NOCENTER; 
 

Chapter 

%
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DATA Step 

The DATA step is used to create permanent or temporary datasets. It is also used to create new 
variables, modify existing variables, and limit the number of variables or observations. In a DATA step, 
you can do any or all of the following activities: 

�� Construct new variables. For example, to construct a variable of active duty by sex: 

/*  Active duty males   */ 
IF XSEXA = 1 AND XBNFGRP = 1 THEN XSEX_AD = 1;   
*  Active duty females; 
ELSE IF XSEXA = 2 and XBNFGRP = 1 THEN XSEX_AD = 2; 
ELSE XSEX_AD = .;   /*  missing value  */ 

 
[Note: the two methods to insert comments: enclosed within /*   */ or beginning with * and ending 
with a semicolon] 

�� Modify existing variables. For example, if the respondent is in region 7, the respondent will be 
placed in the combined region 7/8: 

IF XREGION = 7 THEN XREGION = 8 
 

�� Limit the number of variables. Use a KEEP statement: 

KEEP XREGION CACSMPL H07050 H07014; 
 

�� Limit the number of observations. Use a subsetting IF: 

/*  Keep only TNEX region 3 observations  */ 
IF XTNEXREG = 3; 

 
�� Create a new temporary dataset. For example, CAC_1 is a temporary file of observations for only 

those respondents in catchment area 1: 

LIBNAME INFORMA ’F:\HCSDB07\FORMA’; 
DATA CAC_1; 
/*  Input file is HCSDB07  */ 
SET INFORMA.HCSDB07; 
IF CACSMPL = 1; 
RUN; 

 
�� Create a new permanent dataset. For example, OUT.CAC_9901 is a permanent dataset only of 

out-of-catchment north respondents: 

LIBNAME INFORMA ’F:\HCSDB07\FORMA’; 
LIBNAME OUT ’C:\HCSDB07\FORMA’; 
DATA OUT.CAC_9901; 
SET INFORMA.HCSDB07; 
IF CACSMPL = 9901; 
RUN; 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 
 
 

05/24/07  21 

� PROC TABULATE 

PROC TABULATE produces summary statistics in a table layout. The table can have up to three 
dimensions: page, row, and column. Within any dimension, multiple variables can be reported one after 
another or hierarchically. Useful statistics that are available in PROC TABULATE include: 

�� N  number of observations with nonmissing values 

�� NMISS  number of observations with missing values 

�� MEAN  the arithmetic mean 

�� SUM  the sum 

�� PCTN  percent that one frequency represents of another frequency 

�� PCTSUM percent that one sum represents of another sum 

The essential elements to execute PROC TABULATE are outlined below (items within <  > are not 
required): 

PROC TABULATE DATA=your dataset <option list>; 
CLASS class variables; 
VAR analysis variables; 
TABLE << page expression, > row expression, > column expression </ table options >; 
WEIGHT FWRWT; 
RUN; 
 

If the input file is to be limited to a specific population, a separate DATA step can precede the 
TABULATE, or a WHERE statement can be used within the TABULATE procedure. For example, to 
create a table from only respondents in catchment area 1, you would use the following statement after 
the PROC TABULATE statement: 

WHERE CACSMPL = 1; 
 

CLASS variables are any variables that are used for grouping; variables such as XTNEXREG, XSEXA, 
and CACSMPL are good examples of class variables. Class variables can be either character or 
numeric and typically have a discrete number of values. Unless MISSING is specified in the options list 
in the PROC TABULATE statement, any observations with a missing CLASS variable will be dropped 
from the table. 

The VAR statement identifies all analysis variables for a table. Analysis variables must be numeric and 
can be either discrete or continuous. SAS excludes missing values when computing statistics such as 
means and percentages. 

The WEIGHT statement identifies the numeric variable whose value is used for weighting each 
analysis variable. In the HCSDB for Quarter II, 2007, the weight variable is FWRWT. 

The TABLE statement defines the table features. Every variable listed in this statement must be 
classified as either a class variable or an analysis variable in the CLASS or VAR statements. A comma 
separates each table dimension (page, row, and column). If there are three dimensions, the first is the 
page, the second is the row, and the last is the column. If there are only two dimensions, the first is the 
row and the second is the column. Tables with only one dimension are in column form. Each 
dimension expression is composed of the same following elements:  
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�� Analysis variables 

�� Class variables 

�� The universal class variable ALL, which summarizes the class variables in the same group or 
dimension 

�� Keyword for the statistic to be performed, such as MEAN, SUM, or PCTSUM 

�� A format modifier, which defines how to format values in cells. For example, F=8.2 will present 
values with a maximum of 8 positions and 2 digits to the right of the decimal. 

�� Labels, which temporarily replace variable names and statistic keywords. These labels have the 
form ='label'; for example, XTNEXREG=’TNEX Region’ or MEAN=’ ’ (to eliminate the word MEAN 
from the headings). 

�� Crossing operator * (asterisk). The asterisk is used to cross elements within the same dimension. 
For example, you would use XENRLLMT*XSEXA to cross enrollment status by sex. The asterisk 
is also used to connect the statistic (e.g., MEAN, SUM) to the appropriate dimension; for example, 
to calculate the mean of respondents’ satisfaction with all health care in the last 12 months, you 
would use H07037 *MEAN. 

�� Denominator definitions are enclosed by < > (brackets). 

�� Concatenation operator is a single space between elements in a dimension. For example, to 
concatenate satisfaction with all health care in the last 12 months with satisfaction with health plan, 
you would use H07037   H07048. 

�� Grouping is accomplished with parentheses. Below is an example of grouping, concatenation, and 
crossing within a single dimension: 

(XBNFGRP  ALL)*XSEXA 
 

The SAS Display Manager System 

The SAS Display Manager system provides an interactive tool for running SAS commands, like those 
given above, in the Windows environment. Double clicking the SAS icon on the desktop begins the 
SAS session. When you first enter SAS version 8, the following screen opens. 
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The screen is divided into two windows, a Log window above and an Editor window below. 

The Window Bar at the bottom of the screen includes tabs for the Log and Editor windows with an 
additional tab for the Output Window. Clicking on the Output tab will open the Output window. The 
instructions in this document will outline options for setting up the Editor and for displaying the windows 
themselves. 

The default editor for version 8 is the SAS Enhanced Editor which is color coded to check SAS syntax.  
Another editing option is to use the Program Editor which includes line editing options. We will describe 
procedures for setting up the Program Editor. 

Click on View and select Program Editor as in the following: 

 

The lower Editor Window has now changed to Program Editor as in the following screen: 
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Open the Tools menu and choose Options and preferences. 

 

 

Many of these settings are system default options. To add a command line to the three windows, do 
the following.  Click on the View tab and click in the box opposite Command Line as follows: 
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Click on OK and a command line will be added as in the screen below. 

 

 

Each window shows the word Command followed by an arrow. Commands may be typed at this 
location. To arrive at the command line, depress the Home button on your keyboard. The cursor will 
appear opposite the arrow. 

Toggling among the windows may be accomplished by typing the desired window name at the 
command line and pressing Enter. SAS recognizes Pgm as the abbreviated reference to the Program 
Editor and Out as a shortened name for the Output window. A few keystrokes allow you to navigate 
among the windows. For example, the command line lets you continue to customize our SAS session 
as follows. 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 
 
 

05/24/07  26 

In order to more easily distinguish between the SAS windows, it may be preferable to change the 
background color of selected windows. As an example, set the background color of the Log window to 
yellow and the Output window to gray. Press the Home key to arrive at the command line. Type Log 
opposite the arrow to toggle to the Log window. Type the command, color back yellow (or some other 
color) on the command line. Your screen will resemble the following. 

 

 

Press Enter to process the commands and the window will shade to yellow. Toggle to the Output 
window by typing Out and keying Enter. Type color back gray and key Enter. Return to the Program 
Editor and the screen will look like the following.  
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All SAS statements for building and processing SAS datasets are typed into the Program Editor. A SAS 
session may involve typing statements like the ones above for library reference, computing new 
variables, data steps, etc. Entering a long series of statements in such a small space may be awkward, 
so another arrangement for the windows may be preferable. 

Cascading the windows is one option. To cascade the windows, open the Window menu, and choose 
Cascade as indicated in the following. 

 

 

 

Clicking the option Cascade produces the following result. 
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Each window is partly superimposed on the other. The colors distinguish between windows at a glance. 
With the Program Editor in front, SAS statements may be typed there with relative ease. As a final 
option, you can enlarge the Program Editor to fill the entire screen. At the command line, type zoom as 
in the following: 

 

 

 

The window changes to fill the screen.  

 

One more option for customizing screens is explained below. This involves adding line numbers to the 
editing environment in the Program Window. After adding the line numbers, many useful line-editing 
commands become available (see the SAS Manual). At the Command line type “numbers on” as in 
the following screen.  
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The line numbers appear at the left of the full screen Program Editor as in the screen below, and the 
SAS statements can be typed into the screen and edited. 

 

 

 

Below is an example of a PROC TABULATE to construct a table of health status and satisfaction with 
health plan by beneficiary group and gender for respondents in TNEX region 3. Beneficiary group 
(XBNFGRP) and sex (XSEXA) are both class variables with a discrete number of values. The columns 
of the table are beneficiary group broken out by sex, a total for each beneficiary group, and a region 
total. The variables (H07048 and H07066) are the analysis variables appearing as the rows of the 
table. The statistic that we want to see is the weighted mean of these variables for each group in the 
table and for the entire region as a whole. 
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Enter the following SAS statements into the Program Editor. 

 OPTIONS PS=79 LS=95; 
 LIBNAME IN ’C:\FILES\DoD\ADULT 2007’; 
 LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2007\FMTLIB’; 
 PROC TABULATE DATA=IN.HCS072_1; 
 WHERE XTNEXREG = 3;   /* limit to TNEX Region 3  */ 
 CLASS XBNFGRP XSEXA; 
 VAR H07048 H07066; 
 WEIGHT FWT; 
 TABLE (H07048 H07066)*MEAN,    /* Row Dimension */ 
  XBNFGRP*(XSEXA ALL)  ALL;    /* Column Dimension */ 
 TITLE “Table 4.1”; 
 TITLE2’ Constructed Beneficiary Group by Gender for TNEX Region 3'; 
 RUN; 
 

Key Home and type the command SUBMIT on the Command Line. Submit instructs the SAS system 
to process the commands written in the Program Editor. Your screen should resemble the following. 

 

 
 

 

Enter the Submit command, and the SAS statements disappear from the Program Editor.  If a table is 
successfully produced, the Output window will open and the table will be displayed. If no output is 
produced, then SAS has encountered an error. SAS statements about the error can be seen and 
evaluated in the Log window. In all cases, the Log window should be carefully examined after SAS 
statements are processed. SAS may produce a table even if there are errors in the program, so the 
table may not be correct. 

No table was produced for this run. The error is indicated in the Log Window as shown below. 
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The variable FWT was not found in the dataset. Type Pgm on the Command line to return to the 
Program Editor. Type Recall on the Command line and the program statements will reappear in the 
window.  

You can correct the error by entering FWRWT, the correct variable name, in the weight statement. 
Then, rerun the procedure.  

The corrected program produces the following output.  

 
 

 
The result of this process is Table 4.1. 

Note that the TITLE statement defines the heading for each page. Titles of more than one line are 
entered as TITLE, TITLE2, etc. 
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The format library is the key to interpreting values of discrete variables. For example, in the program 
above, the format library found at C:\FILES\DoD\ADULT 2007\FMTLIB indicates that a Value of 1 for 
XSEXA means male, and a value of 2 for XSEXA means female. Similarly, if XBNFGRP equals 1, the 
respondent is active duty; if XBNFGRP equals 2, the respondent is a family member of active duty 
personnel; if XBNFGRP equals 3, the respondent is an under-65 retiree or a survivor or one of their 
family members; if XBNFGRP equals 4, the respondent is a 65-or-over retiree, survivor, or one of their 
family members. 

Since formats are associated with the variables in the HCSDB, formatting is automatic as long as SAS 
can locate the format library. Error messages will result if the LIBNAME LIBRARY statement is not 
present. If the format library is not available for some reason, use the statement 

FORMAT _ALL_; 
 

within the PROC TABULATE to prevent SAS from searching for the missing format library. The default 
formats in the format library were used to produce the table described in the previous section.  

'������������
���
Format modifiers and temporary labels improve the appearance of a table. In Table 4.1, the values of 
the statistics are of the form x.xx. If each cell is defined to be six positions wide with two positions to the 
right of the decimal, there is adequate space plus some extra room to keep the table from looking 
crowded. This is done by crossing the statistic with the format modifier: 

MEAN*F=6.2 
 

Labels are attached to all variables in the HCSDB. You can use temporary labels to override the label 
within the SAS dataset. It is not always necessary to use both the variable label and the formatted 
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values for each value of a class variable. In the previous example, the formatted values of XBNFGRP 
are active duty, family members of active duty, etc. which we know to be beneficiary groups; the title 
also tells you that these are beneficiary groups. The table can be made attractive by deleting the 
heading for XBNFGRP by including a blank for the temporary label: 

XBNFGRP=’ ‘ 
 

Similarly, because the statistic being reported here is a mean, you do not need MEAN on each row. 
You can add or eliminate a label and include a format modifier to the same variable: 

MEAN=’ ‘*F=6.2 
 

The headings for XSEXA and ALL can be improved: 

XSEXA=’Gender’ 
ALL=’Group Total’ for the ALL that is crossed with XBNFGRP 
ALL=’Total’ for the TNEX Region 3 total 

 

The new program looks like this: 

OPTIONS PS=79 LS=95; 
 LIBNAME IN 'C:\FILES\DoD\ADULT 2007'; 
 LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2007\FMTLIB’; 
 PROC TABULATE DATA=IN.HCS072_1; 
 WHERE XTNEXREG = 3;   /* limit to TNEX Region 3  */ 
 CLASS XBNFGRP XSEXA; 
 VAR H07048 H07066; 
 WEIGHT FWRWT; 
 TABLE (H07048 H07066)*MEAN=’ ‘*F=6.2,    /* Row Dimension */ 

/* Column Dimension */ 
XBNFGRP=’ ‘*(XSEXA=’Gender’ ALL=’Group Total’)  
ALL=’Total’;   
 

TITLE “Table 4.2”; 
 TITLE2 ‘Constructed Beneficiary Group by Gender for TNEX Region 3'; 
 RUN; 
 
Typing these statements into the Program Window produces the following screen. 
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After the Submit command is entered, the following table is displayed in the Output window. 

 

 
 

 
The resulting output is in Table 4.2. 
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Although the label for MEAN is deleted, there is still a space in the table for this label. You can eliminate 
this blank space by using the TABLE option of ROW=FLOAT. SAS row headings are automatically 
allocated; you can override this by using the TABLE option of RTS=n where n is an integer value 
specifying the number of print positions to be used for row headings. If you decide that we don’t need 
the label ‘Gender’ for XSEXA because ‘male’ and ‘female’ are self-explanatory, the revised program is 
as follows: 
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OPTIONS PS=79 LS=95; 
 LIBNAME IN ‘C:\FILES\DoD\ADULT 2007’; 
 LIBNAME LIBRARY ‘C:\FILES\DoD\ADULT 2007\FMTLIB’; 
 PROC TABULATE DATA=IN.HCS072_1; 
 WHERE XTNEXREG = 3;   /* limit to TNEX Region 3  */ 
 CLASS XBNFGRP XSEXA; 
 VAR H07048 H07066; 
 WEIGHT FWRWT; 
 TABLE (H07048 H07066)*MEAN=’ ‘*F=6.2,    /* Row Dimension */ 

/* Column Dimension */ 
XBNFGRP=’ ‘*(XSEXA=’ ’ ALL=’Group Total’)  
ALL=’Total’ / ROW=FLOAT   RTS=32;   
TITLE “Table 4.3”; 

 TITLE2’ Constructed Beneficiary Group by Gender for TNEX Region 3'; 
 RUN; 
 

Typed into the Program Window, the revised program appears as follows. 

 

 
 

The output table is displayed in the Output Window as follows. 
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The result is Table 4.3. 
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When calculating percentages, it is necessary to appropriately define the denominator. To calculate a 
column percentage, the denominator definition must include all class variables that define the row. For 
example, if you want to look at the percentage of people in your region and each of the catchment 
areas who answered yes (or no) to question 14, ‘In the last 12 months, did you see a specialist?', your 
TABLE statement in the TABULATE procedure would look like this: 

 
WHERE XTNEXREG = 2; 
TABLE H07014 ALL=’Total’, 
(All=’TNEX Region Total’  CACSMPL)*PCTN<H07014  ALL>=’Percent’;   

 

Table 4.4 includes a program and its output for calculating column percentages.  
The program statements in the Program Editor appear as follows. 

 

 
 

The submitted statements produce the following output. 
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The statistic N is included with PCTN to make it easier to verify that the denominator definitions have 
been set up properly. After you check to see that the percentages are accurate, the N statistic can be 
removed. Note that the output for Table 4.4 is unweighted. The N statistic (and PCTN statistic) is 
always unweighted even if a WEIGHT statement is included. 

Similarly, if you want to look at the percentage of TRICARE enrollees (and non-enrollees) by gender 
who report seeing a specialist in the past 12 months, this would be a row percentage. To calculate a 
row percentage, the denominator definition must include all class variables that define the column. Your 
TABLE statement would look like this: 

TABLE H07014 ALL=’Total’, 
XENRLLMT *(XSEXA=’ ‘ All=’Group Total’)* 
PCTN<XENRLLMT*XSEXA  XENRLLMT*ALL>=’Percent’; 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 
 
 

05/24/07  44 

 
Notice that there are no parentheses used in the denominator definition. Because parenthetical 
groupings are not allowed in the denominator definition, all crossings and concatenations must be 
included. As noted above, the N and PCTN statistic are unweighted counts of CLASS variables. If you 
want to produce a weighted count and percentage for this table, you would include FWRWT (the 2007 
weight variable) as an analysis variable in the VAR statement and in the column crossing of the TABLE 
statement; the statistics to be generated should be specified as SUM and PCTSUM. A program and 
output to demonstrate weighted row percentages appears in Table 4.5.  

The following screen shows the new program typed into the Program Editor. 
 

 
 

These commands produce the following output. 
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Here, as above, the SUM statistic is included to help determine the accuracy of the denominator 
definition. 

 
Additional information about running SAS is available from the SAS Institute. Please consult the 
appropriate manuals for more detailed information. 

See Table 4.5 to view the entire table. 
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The 2007 Adult HCSDB dataset is in an SPSS format. SPSS is a computer software system used for 
data management, summarization, and analysis. SPSS can be run interactively, using menus, or in 
batch mode, using syntax commands. This guide instructs users on how to use SPSS dialog boxes to: 

�� Construct new variables 

�� Recode existing variables 
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�� Select cases for analysis 

�� Weight cases for analysis 

�� Create customized tables 

As you use the dialog boxes, you generate syntax automatically. This syntax may be pasted into a 
syntax file for future use or for modification.  

Locating and opening the data file 

To begin an SPSS session, double click on the SPSS icon on your desktop. The Data Editor window 
will open and present a blank spreadsheet like the following screen: 

 

 

 

Click on File in the upper left corner to open the following menu: 
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Select the Open option or choose a file from the list displayed. Open and data produces the following 
screen: 

 

 

 

If the file is not in this directory, navigate through your folders until you locate it. Mark the file and click 
Open. You will be returned to the spreadsheet Data Editor with the file on view. The Quarter II, 2007 
Adult HCSDB dataset has been opened and is displayed below. 
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Constructing new variables 

Data can be evaluated from many different aspects. It is sometimes useful to build new variables from 
combinations of the existing ones and to examine their distributions. 

For example, the variable in the file for beneficiary group at the time of sampling is called xbnfgrp, and 
the variable for sex is xsexa. The value 1 for xbnfgrp indicates that the individual is on active duty. The 
relationships for constructing a new variable of active duty by sex are: 

  Active-duty-males:  xsexa=1 and XBNFGRP=1 

  Active-duty-females:  xsexa=2 and XBNFGRP=1 

Open the Transform menu and select Compute as in the following: 
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The following dialog box will open: 

 

 
 

You can build the new variable in two steps to express the two conditions. The first task is to give the 
new variable a name and its first value. Enter the Target Variable slot and name the new variable 
sex_ad. Next, assign the value 1 to sex_ad by entering it into the slot for Numeric Expression. Your 
screen should look like the following: 
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Once you we have assigned the value 1 to sex_ad, you can build the condition that qualifies the 
assignment. Click on If and open the following dialog box: 

 

 
 

 

Click on the circle indicating Include if case satisfies condition, and the black dot will move to that circle. 
The slot underneath will open, ready for your input. Build the “if” condition. Write it directly into the slot 
or move the elements into the slot from the given options. Add the elements xsexa = 1 & xbnfgrp = 1. 

The screen should resemble the following: 

 
 

Click on Continue and return to the previous screen, which will now look like this: 
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Your condition will be written next to the If button. Click on OK to exit the dialog box, and the variable 
sex_ad will be created with its value set to 1.  

The next step is to build the second condition for the new variable, which will set it to the value 2. 
Reopen the Compute dialog box. The commands you just gave still appear in the dialog box. Simply 
assign the value 2 to  sex_ad,  press If, and enter the new condition to identify active duty females. 
Click Continue, and finish with OK. The condition, if xsexa = 2 and xbnfgrp = 1, will be added to the new 
variable sex_ad.  

Once you have created a new variable, you may want to add it permanently to the dataset. The new 
variable is computed for each case in the file and added to the view in the Data Window after the last 
variable in the dataset. The variable name is the column heading.  

Since the HCSDB data set carries Read-Only status to protect it from corruption, changes to it cannot 
be saved. At the end of the day, when the work session ends and you exit SPSS, the file will revert to 
its former status and the new variables will be lost. The solution is to save the dataset under a new 
name when you exit. Choose the Save As option on the File menu, and you will be prompted to name 
the file and to save it in a folder of your choosing. Give the file a new name and save it. Open the new 
expanded file anytime for processing. 

Suppose you do not want to use up your disk space for expanded copies of the dataset. Another option 
is to save the syntax you have generated in a file that can be run as it is needed. Syntax is a written 
instruction generated by the commands you give in a dialog box. These “sentences” can be saved in a 
file and executed when needed. This is the batch mode of processing syntax commands. Syntax files 
take up very little space.  

Experienced SPSS programmers, who have mastered SPSS syntax, often prefer to work only in batch 
mode. This option is available to users who have not mastered the syntax language. You can paste the 
commands, generated interactively in the dialog box, onto a syntax file.  

Recall the compute example for the new variable sex_ad. The screen below is the result of assigning 1 
to sex_ad according to an If condition. You clicked on OK to set the value. Returning to the screen and 
clicking on Paste writes the command to a syntax file. 
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Click on the Paste button, and the syntax window below will open with the syntax written in it. 

 
 

 

Now return to the compute dialog box. 

 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 
 
 

05/24/07  54 

 
 

 

Assign the value 2 to sex_ad  as in the diagram above. Select Paste, and these commands will be 
appended to the syntax file. 

 

 
 

 

The results appear in the screen above. SPSS gives default names to syntax files, such as Syntax1, 
Syntax2, etc., as they are created. It is a good idea to save the syntax, re-naming the file using the 
Save As option on the File menu. Use a name that has some meaning to you, e.g., New_computes. 
The file will automatically receive the suffix .sps. 
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Another option for adding new variables to the dataset is to Recode existing variables into new 
variables. A common example involves grouping an age variable into age categories as shown below, 
using the variable DAGEQY, which exists on our dataset. DAGEQY is coded in years from 18 to 92, 
which can be grouped into four age categories: 

18 to 34 = 1 - label: “young adult” 

35 to 49 = 2 - label: “mature adult” 

50 to 65 = 3 – label: “middle-age” 

66 to 92 = 4 – label: “senior citizen” 

The new variable is called age_grp. 

DAGEQY is a string variable.  In order for it to be recoded using grouping criteria, it must be converted 
to a numeric variable. In the data window go to the column for the variable DAGEQY and click in the 
gray area at the top of the column causing the variable to be selected as the following screen indicates. 

 

 
 

Click on the Variable View tab at the lower left of your screen and the screen will change to the 
following: 
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In the Type column click on the gray square and the following Menu will open. 

 
 

 
Transfer the black dot from String to Numeric as follows: 
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Click on OK to set the changes.  Click on the Data View tab to return to the Data Editor window. 

Now from the Transform menu, choose Recode and Into Different Variables as pictured below: 

 

 
 

 

The following dialog box will open: 
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Move DAGEQY from the variable list on the left to the box labeled Input Variable -> Output Variable. 
In the Name slot, enter the new variable name age_grp. Enter Age Categories, the variable label, in 
the Label slot. Click on Change. The dialog box should look like the one below. 

 

 
 

 

Click on Old and New Values, and the following dialog box will open: 
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The next step in grouping the age variable is to specify the existing values of Age to be recoded. To do 
this, click on the Range circle under Old Value. 

 

 
 

 

Once the appropriate slots are open, you have four ranges to enter.  

First, enter 18 through 34 in the slots provided under Range. Next, enter the value 1 in the Value slot 
under New Value. Add is now illuminated.  
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Clicking on Add produces the following result: 

 

 
 

 

The specified range appears in the box labeled Old -> New, and the Range and Value slots have 
been cleared to permit additional entries.  

The three remaining ranges are built in the same manner, adding each specification, until the dialog 
box looks like the one below. 
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Click on Continue and return to the previous screen. 

 

 
 

 

Click on OK to exit the screen. The new variable age_grp has been created. The Recode syntax can 
be pasted to a syntax file. 

The final task is to create the value labels for the new variable age_grp. Labeling variables makes 
output from statistical reporting procedures much clearer and more elegant.  
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In the Data Window, go to the column for the new variable age_grp and double click in the gray area 
containing the variable name. The screen will change to variable view: 

 

 
 

The variable age_grp is shown with its attributes. 

Click in the cell under Values and the following dialog box will open: 

 

 
 

 

You can then begin to label the values of age_grp. Enter 1 in the slot marked Value, and enter the 
label Young Adult in the slot marked Value Label. The screen will look like the following: 
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Add is now illuminated. Click on Add and the text of your command will appear in the central box, 
clearing the slots for further entries, as in the next screen. 

 

 
 

 

Build the other three labels until the screen looks like the following: 
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Click on OK and the screen will appear as follows: 

 

 
 

 

Click on the Data View tab to return to the data screen. 
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Limiting the Number of Variables 

The HCSDB dataset contains many variables. To speed up software performance time, it may be 
desirable to limit the number of variables for analysis. There are ways to do this.  

The first is to Save a subset of variables in a new file with a new name. This option is available only 
through syntax. The Keep or Drop command lets you save a subset of variables. The choice of Keep 
or Drop is dependent on which list is shorter to write. 

For example, suppose you want to run some procedures to evaluate the rating of all experiences with 
the health plan as it relates to the beneficiaries’ state of health. You are also interested in people that 
see a specialist, and in differences within these groupings by gender. Moreover, you want to look at 
regional differences and differences among catchment areas by beneficiary group and enrollment. You 
can do all the work on a subset of only nine variables, saving them in a separate file. 

To write the syntax, open a syntax window. If you want to create a new syntax file, choose New, 
Syntax on the File menu as in the following: 

 

 
 

 

A blank syntax window will open. 

Write the following command, substituting the file name and directory specification: 

SAVE OUTFILE=’C:\MYFILES\HLTHCARE.SAV’/KEEP=XTNEXREG XSEXA XENRLLMT 
CACSMPL FWRWT XBNFGRP H07014 H07048 H07066.   

as in the following: 
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Upper case is optional. Be sure to enclose the entire file name in single quotes and to type a period at 
the end of the command. 

Run the command by choosing the Run menu and selecting All from the choices.  

 

 
 

 

Open the new file according to the specifications at the beginning of this chapter.  

The second way to limit the number of variables for analysis is to define a subset of variables that will 
appear in the dialog boxes for procedures. Using the Utility menu, define a subset of variables as in 
the following: 
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Select Define Sets. 

 

 
 

 

Insert a name for the subset of variables in the slot labeled Set Name. Move the variables you want to 
subset from the list on the left to the slot marked Variables in Set. By way of illustration, we will move 
the nine variables selected for the day’s processing. 

The screen should look like the following: 
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Click on Add Set to save the set specifications. The screen will change to the following: 

 

 
 

 

The set is now available for use. To use the set, Close the dialog box, reopen the Utilities menu, 
choose Use Sets…, and receive this screen: 
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. 

 

Move HLTHCARE from the left slot to the right slot, which is labeled Sets in Use. Transfer 
ALLVARIABLES from the right to the left slot. Leave NEWVARIABLES where it is. OK saves this 
change. 

 

 
 

  

Until you change this specification, only nine original variables and any new variables will appear in the 
dialog boxes associated with procedures.  
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Limiting the Number of Observations 

There are many ways to limit the number of observations available to statistical reporting procedures. 
The method illustrated here involves using filter variables with a menu-driven Filter By option. Using 
filters deactivates but does not delete cases from the file. A diagonal line appears next to the filtered 
cases in the Data Window. 

The first task is to compute a filter variable for all the cases in the file.  A filter variable has two 
values: 0 and 1. The 1 indicates that the case will be included for procedures. The 0 flags the case 
for removal. 

For example, suppose you want to produce a table for people who live in the West, i.e., cases for which 
the variable xtnexreg = 3. You would build a filter variable named filtr_3, which has the value 1 
associated with the cases in the West and 0 for all the other cases in the file. The logic is: if      
xtnexreg = 3, then filtr_3 = 1, else filtr_3 = 0. 

The screen below shows the final step in computing the filter variable. The variable was first initialized 
to 0. Then, the “If” condition was built for setting the filter variable to 1. You are now working with a 
subset of variables, allowing the dialog boxes to be used more efficiently. 

 

 
 

 

The screen that follows shows the syntax that was generated as you built the variable filtr_3. 
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Once you build the filter variable, you can apply it for analyzing only those people from the West. 

Using the Data menu, choose Select Cases. 

 

 
 

  

In the dialog box, check Use filter variable. Move the variable filtr_3 from the variable list on the left 
side of the dialog box into the slot provided, as indicated below. Check that the option Filtered is 
checked under Unselected Cases Are. This is the default option. 
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Click OK and exit the dialog box. 

When you return to the Data Window, notice the slanting line next to some of the cases in the file. 
Those cases have been filtered out. 

 

 
 

  

You can now produce tables for the subset of cases.  
 
When using filter variables, it is important to check the filter status and to adjust it to fit the present 
need. Filtered cases are not available for procedures. Moreover, a filter is in effect until it is turned off or 
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until another filter is activated. Check the status line at the bottom of the Data Editor window to see if a 
filter is activated. In the example above, Filter On is indicated on the status line. To see which filter is 
active, you must re-enter the Select Cases dialog box. There you can deactivate the filter or activate a 
new one. 

To deactivate a filter, choose All cases and OK as in the screen below. 
 

 
 

Weighting Data 

The data file includes a weighting variable, FWRWT, which should be applied to all procedure runs. 
Again, using the Data menu, choose Weight Cases. In the dialog box, choose Weight cases by. 
Move the weight variable from the list on the left into the slot labeled Frequency Variable on the right 
as shown below: 
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Click on OK and exit the dialog box. The indication that the data is weighted appears on the status line 
near the bottom of the screen. As in the following screen, Weight On is specified there. 

 
 

The status line indicates if the data is weighted. Which weight variable is in effect can only be checked 
by re-entering the Weight Cases dialog box. Weighting stays in effect until it is canceled or until 
another weight variable is activated. 

BUILDING TABLES 

Building tables starts with creating a new subset of variables that includes H07014, H07048, H07066, 
cacsmpl, xbnfgrp, xsexa, xtnexreg, xenrllmt, FWRWT, and filtr_3. The procedures Means and 
Crosstabs will probably meet most of your statistical reporting needs. SPSS also offers many options 
for editing the output tables themselves. Some of these options are explained here. 

Calculating Means 

As an example, suppose you want to analyze the health care variables and you want to focus on the 
West ( xtnexreg = 3). Suppose you are also interested in overall differences in the mean rating of 
health plans received as it relates to the beneficiary’s self-evaluation of his health for the West region. 
Within this grouping, you want to examine the effects of the beneficiary group, xbnfgrp, and sex, 
xsexa.  

The health care variables are H07048 – rating of the health plan, and H07066 – assessment of the 
state of health. The statistic you want to see is the mean of the health care variables for each group in 
our breakdown. 

For this analysis, you can use the subset of variables defined above. The subset includes the weight 
variable, FWRWT, which you would activate for procedure runs. The subset also includes the new 
variable, filtr_3, which allows us to select only those cases in the West.  
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Open the Data menu in the Data Window. In the Weight Cases dialog box, activate the weight 
variable fwrwt. Reopen the Data menu and, in the Select Cases dialog box, activate the filter variable, 
filtr_3. On the status line, Filter On and Weight On should appear. 

Open the Analyze menu in the Data Window. Choose Compare Means and Means from the options 
as illustrated below. 

 

The dialog box for the Means procedure will open as in the following screen: 
 

 
 

 

Move the health care variables H07048 and H07066, from the variable list on the left to the box 
underneath Dependent List. These are the two analysis variables. Notice that Layer 1 of 1 is specified in 
the middle of the dialog box. Move XBNFGRP from the variable list on the left into the box under 
Independent List. XBNFGRP is the first grouping variable. The screen should look like the following: 
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Click on Next in the center of the box to create a second layer. The following screen will open: 
 

 
 

 

Notice that Layer 2 of 2 is specified in the middle of the dialog box. Move xsexa from the variable list on 
the left into the box under Independent List. Xsexa is the second grouping variable. The screen should 
look like the following: 
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To set some options, click on Options and the following dialog box will open: 
 

 
 

 

 

On the left of the box is a list of statistics, under Statistics. These are all the possible options for 
statistical output. In the box under Cell Statistics are the default output statistics for the analysis. In this 
case, Mean is the statistic of interest. Highlight Number of Cases and Standard Deviation and move 
them to the box at the left, removing them from the analysis, as follows: 
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Click on Continue and return to the previous screen. Click OK. The Means procedure will run. On the 
status line, Running Means will appear, and a counter for the number of cases processed will be 
activated. 

When Means has finished processing, the Output Navigator window will open automatically. As the 
name suggests, the output window is not just for looking at output. A number of options are available 
for navigating through output, moving tables, and even editing the tables themselves. 

 
 

 
The output is organized into two sections. On the left side is a navigating tool, which lists the 
components of the right side, the actual output. In the left pane, Means is indicated, and indented 
under it appear Title, Notes, Case Processing Summary, and Report. Clicking on Means highlights 
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and selects all the elements. Lines appear around these elements in the right pane. The indenting 
indicates that the elements are hierarchically organized, with Means at the top. Clicking on any of the 
sub-elements selects just that element. 

A closer look at the left pane reveals another feature. Hiding underneath the element icons are book 
icons. The books are either open or closed. If a book is closed, the element is hidden. Notice that the 
book under the Notes icon is closed. This is a default SPSS option. Double-clicking the icon will open 
the book, and the Notes will appear in the output. Double-clicking an open book will close it, and the 
physical element will disappear from the output. Closing a book and hiding the element does not delete 
the element. 

It is possible to select elements in the right pane of the output. Simply click anywhere inside of the 
actual output element, and that element will be selected.  

The output may contain many different procedures. The procedure name will be at the top of the list for 
each section in the left pane. The procedure name does not actually parallel physical output but 
indicates the category of the output elements. 

As you click on each element in the left pane, you will notice that the screen jumps to the actual output 
of the element, in the right pane. When you click on the procedure name, you jump to the beginning of 
the next procedure output. This is a quick way to scroll through your output. It also lets you delete, 
move, and edit selected elements.  

To Edit the Title element, Means, to create a more appropriate title, select the table title by clicking 
once on the Title icon in the left pane. A box now surrounds the title in the right pane. Double-click 
anywhere within this box, and a box appears around Means, as shown in the following screen. 

 
 

 

You have entered the edit mode for this element, and the cursor appears inside the box. You can 
delete the word Means and write a title that relates to the information in the table. A possible title 
appears in the next screen. To exit edit mode, click anywhere outside the box. The change you made 
will be saved.  
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If you navigate to the next element, Notes, you see a closed book. Double-click this item, and the notes 
will appear as follows: 

  

 
 

 

Decide if you want this information to appear in your report. If not, simply double-click the Notes icon, 
and the notes will again become hidden.  

Navigate to Case Processing Summary. The table gives useful information about the number of 
cases included in and the number of cases excluded from a given procedure. This information is 
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important for the researcher but probably not necessary for the report, so you would double click this 
item to hide it. 

Navigate to Report to see the actual table output from the procedure Means. You can view this table 
by scrolling through the output. If the table is large, however, scrolling in the output window can be 
problematic. A better way to review the table is to open it as a Pivot Table Object in a special editor.  

Select the table by clicking the Report icon or by clicking inside the table itself. A box will appear 
around the table. Insert the mouse pointer inside the table and right-click, opening the following dialog 
box: 

 

 
 

Select SPSS Pivot Table Object and Open as pictured below: 
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The table will appear in a new screen superimposed on the output. Maximize this screen as shown 
below. 
 

 
 

In this special editor, there are many options for formatting the table.  

Suppose you want to change the table format from vertical to horizontal. Open the Pivot menu in the 
tool bar and choose Transpose Rows and Columns as shown below: 

 

 
 

The rows and columns will be reversed as shown in the following screen. Though the table appears too 
wide in the viewer, it will fit the page when printed. You can do all the table editing in the left section of 
the table, and the changes will spread through the entire table. 
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You would then notice that certain labels are redundant. The labels, Constructed Beneficiary Group 
and Male or Female - R are the Variable Labels for the variables. The information in these labels is 
echoed in the Value Labels, which are also reproduced in the table. You would delete the Variable 
Labels as follows. 

Click inside the section of the table where the label, Constructed Beneficiary Group, appears. Right-
click to open a dialog box, choosing Hide Dimension Label, as illustrated below. 
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Click inside the table section labeled Male or Female - R and repeat the above procedure. An 
improved table is shown in the following screen. 

  

 
 

The mean values reported are formatted to allow space for the labels of the satisfaction variables. The 
spaces between the values are not pleasing to the eye. You can shorten these labels and add the lost 
information in another place, according to the following procedures: 

Double-click on the label for health state. Delete the text, entering only the words, Health State. Do the 
same for the health care label, entering only the words, Plan Rating.  

Double-click on the word, Report, in the center at the top of the table, right-click, and choose Delete 
from the dialog box. 
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The resulting table is much more readable. You can then add the deleted information to clarify the table 
output. Open the Insert menu and choose Title as in the following: 

 

 

Type in a new title for the table.  The final result appears below. 
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After all the editing changes have been made, exit the Pivot Table editor and return to the output 
navigator. Click on the File menu and choose Print Preview. Zoom in on the page and review the 
appearance of the report. The page will appear as the page below. 

  

 

 

Calculating Percents 

The Crosstabs procedure offers many options for analyzing data. The distribution of cases resulting 
from “crossing” one variable with another is often of interest. The number of cases, row percentages, 
column percentages, total percentages, and residuals are easily reproduced by Crosstabs. A full array 
of statistics is also available. 

The examples given here involve examining relationships between variables, with a view toward the 
number of cases and the percent of cases in cells produced by “crossing” the variables. 

For example, suppose you want to see the percentage of people in the South catchment areas who 
answered “yes” or “no” to the question, “Did you see a specialist in the last 12 months?”  The variables 
in this analysis are cacsmpl – the catchment area, and H07014 – the questionnaire variable. The 
cases for the analysis are from the South only.  

The first task is to build a new filter variable, assigning 1 to the variable when XTNEXREG = 2. You 
would call the variable filtr_2 and build it the same way you built the filter, filtr_3. Cases from the South 
are selected when you activate the filter, and the other cases are filtered out. Check the status line for 
Filter On.  

Next, open the Analyze menu in the Data Window, choosing Descriptive Statistics and Crosstabs , 
as shown below. 
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The Crosstabs dialog box will open as follows: 
 

 
 

 

Move H07014 from the variable list on the left into the box marked Row(s):, and move the variable 
cacsmpl into the box marked Column(s):. The screen will resemble the following: 
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For this analysis, there are no Layer variables, so you can proceed to format the table cells. 
 
Click on Cells... and open the following dialog box. 
 

 

   

Under Counts, Observed is checked. This refers to the cell count, a statistic you want to see, so you 
would leave it checked. Under Percentages, check Column because you are interested in the 
percentage of people in each catchment area. Click Continue and return to the original screen.  

Suppose you also want to see the chi-square statistic. Click on Statistics, and the following screen will 
open: 
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Check Chi-square as in the screen above, click Continue to return to the first screen, and click OK to 
run the procedure. Running Crosstabs will appear on the status line, together with the case counter. 

When the run is completed, the output window will open, and you can proceed to reformat the table. 
For a given work session, SPSS appends new output to previous output--in our case, the Means 
procedure. As shown in the next screen, a second section now appears in the left pane, headed by the 
word Crosstabs. Navigate to the Title section and double-click inside the title box to change the text in 
the box to fit the table, as in the example below. 
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As you did for the Means procedure, you would again evaluate the Notes and examine the Case 
Processing Summary. Hide the Notes and the Case Processing Summary as you did before. 

Navigate to the procedure icon. Follow the procedure for opening an SPSS Pivot Table Object, open 
the table in the special editor and maximize the screen as in the following: 

  

 
 

  

The information you requested is in the table, but the table is hard to read. The first possibility is to 
realign the percent statistic, bringing it into the row dimension. To do this, open the Pivot menu and 
choose Pivoting Trays, as in the following screen: 
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The pivoting tool will appear: 

  

 
 

This tool reflects the table structure: rows, columns, and layers. The icons in the margins of the pivoting 
trays represent the table elements: the variables and the cell statistics. Place the mouse pointer on 
each icon and notice the element name appear. In this example, on the ROW axis, you would find the 
variable, H07014 – saw specialist in the last 12 months, and Statistics – the percent of people in each 
catchment area. On the column axis is the variable, cacsmpl – the catchment area. 

Place the mouse pointer on the Statistics icon. Click and drag the icon from the ROW to the COLUMN 
dimension. The table immediately reformats as in the following screen: 
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Close the pivoting tool and scroll from side to side in the table. Again, the table appears too wide, but 
the report will print properly. Notice that the table is much more readable.  

The label at the top of the table is the Variable Label for cacsmpl. Select it by double-clicking and edit 
it for clarity (see the screen below).  

The table is now formatted to accommodate the long percent label, creating a lot of wasted space. 
Double-click this element, delete the text, and replace it with the word, “Percent”. The empty space 
disappears and the table appears as follows: 

 

 
 

Next, notice that the label for H07014 is awkward. Select and clear it. 

Last, edit the text in the table label so that it better expresses the content of the table. The finished table 
appears as follows: 

 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 
 
 

05/24/07  93 

Check Print Preview to see if the table is acceptable. 
 
The last example shows you how to add a Layer dimension to a Crosstabs analysis. Using the same 
row variable, H07014, suppose you want to look at the percentage of people by their enrollment status 
in TRICARE Prime, xenrllmt, who saw a specialist in the past 12 months. Suppose you are also 
interested in sex differences, xsexa, among the groupings. Xsexa is the Layer variable. You want to 
remain in the South region, using filtr_2 as the filter variable. The cases will be weighted by FWRWT. 

The status line indicates Weight On and Filter On. Verify that both the weight and the filter variables 
are appropriate. 

Once more, open the Crosstabs dialog box, enter the analysis variables, and set the Cells options, 
checking Column under Percentages until the dialog box looks like the following:  

 

 
 

Do the following: 

�� Run Crosstabs. 

�� Edit the Title element in the Output Navigator. 

�� Examine Notes and the Case Processing Summary to verify that the crosstab ran as expected. 

�� Open the table as an SPSS Pivot Table Object, and the following will appear: 
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The table is difficult to read, but you can improve it by doing the following.  

 

Select the Pivot menu to activate the Pivoting Trays. The table structure is reproduced in the tool as 
follows: 

 

 

    

Place the mouse pointer on each small icon to find the second grouping variable, labeled Male or 
Female - R, in the ROW dimension. Move it to the COLUMN dimension, and the table changes to the 
following: 
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Then drag the Statistics icon to the COLUMN dimension to produce the following change: 
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Close the Pivoting Trays and hide the dimension label, Male or Female - R, in the table. Then, 
change the percent label to “Percent” and delete the label for H07014 in the row dimension. Last, 
revise the label above the table to make it more informative. 

The resulting table is both clear and informative. 

 

 
 

  

The Print Preview, as in the view below, shows how the report will print.  
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Sampling error occurs when estimates are derived from a sample rather than a complete census of the 
population. The sample used for a particular survey is only one of a large number of possible samples 
of the same size and design that could have been selected. Even if the same questionnaire and 
instructions were used, the estimates from each sample would differ from the others. The standard 
error (or square root of the variance) indicates the magnitude of the sampling error and thus measures 
the precision expected from a particular sample. 

It is desirable to assess the accuracy of an estimate. The standard error of a survey estimate measures 
the precision with which an estimate from one sample approximates the true population value. The 
standard error can be used to construct confidence intervals for survey parameters, within which the 
true parameter lies within a measurable degree of certainty.  

This section explains how to estimate standard errors or variances for estimators computed from the 
Quarter II, 2007 Adult HCSDB. For a full discussion of variance estimation methods, see Wolter (1985) 
and references cited therein. 

*����
�����������	
�+��
	���

To account for complex estimators for the sample design,1 it is customary to use either Taylor series 
linearization or a resampling method for variance estimation. Neither variance estimation method is, in 
general, better so the choice of one or the other is largely a matter of convenience. To help users to 
estimate standard errors using Taylor series linearization or jackknife replication, the public release files 
for the Quarter II, 2007 Adult HCSDB include the following variables: 

�� The stratum variable (STRATUM) for the Taylor series linearization method 

�� Quarterly final weight (FWRWT) and jackknife replicate weights (FWRWT01 to FWRWT60) 

Two popular software packages are available for performing Taylor series linearization or the jackknife 
replication method:  SUDAANTM (Shah et al. 1997) and WesVarPC (Brick et al. 1996), respectively.2 
The discussion below explains how SUDAAN and WesVarPC are used to calculate variance estimates 
using Taylor series linearization and jackknife replication methods. 

Taylor Series Linearization Method 
 

For most sample designs (including the 2007 Adult HCSDB), design-based variance estimates for 
linear estimators of totals or means can be obtained with explicit formulas. However, nonlinear 
functions such as ratios do not have exact expressions for the variance. The Taylor series linearization 
method approximates the variance of a nonlinear estimator with the variances of the linear terms from 
the Taylor series expansion. Woodruff (1971) presented applications of this technique to sample 
surveys. Details on this method can also be found in “The 2007 Health Care Survey of DoD 
Beneficiaries: Adult Technical Manual”. 

                                                      
1The 2007 HCSDB uses a stratified sampling design. For details, see “Health Care Survey of DoD Beneficiaries:  2007 Adult 
Sampling Report.”  Washington, DC: Mathematica Policy Research, November 2006. 

2The latest version for SUDAAN 8.0 can be used for replication methods including jackknife variance estimation.  SAS 8.0 
also includes procedures for performing Taylor series utilization, but SUDAAN contains more options. 
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To calculate variance estimates based on the Taylor series linearization method with HCSDB’s 
stratified sampling design, both the stratum variable (STRATUM) and the final weight (FWRWT) 
specified for each data record are needed.  

SUDAAN incorporates the final analysis weight and the survey design to obtain estimates and their 
sampling errors. With a small overall sampling rate of about 1 percent, you can use the with-
replacement design procedure (STRWR) in calculating standard errors.  

All SUDAAN procedures require the following: 

�� The specification of sampling designs. The terminology for the stratified with-replacement sample 
design is DESIGN = STRWR. 

�� The data file sorted by the variable specified in the NEST statement. For the Quarter II, 2007 Adult 
HCSDB, the data file for adults must be sorted by STRATUM before using any SUDAAN 
procedure. 

�� A FILE TYPE appropriate for SUDAAN, if you use a stand-alone SUDAAN program. For example, 
some SUDAAN PC versions under Windows or MS-DOS accept only V6.02 through V6.04 SAS 
files, and FILE TYPE must be specified as SAS. SAS-callable SUDAAN is also available and can 
be invoked directly in a SAS program with any available SAS file as input; FILE TYPE is not 
needed here. 

�� The WEIGHT variable is FWRWT 

The following program is an example of how to use SUDAAN to calculate variance estimates for a 
mean statistic. Suppose you want to estimate: 

�� The rating of a specialist (H07015), among all beneficiaries in the past 12 months who saw a 
specialist (H07014=1) for each region (XTNEXREG) 

 PROC DESCRIPT DATA=HCSDB /*FILETYPE=SAS*/ DESIGN=STRWR; 
WEIGHT FWRWT; 
NEST STRATUM; 
SUBPOPN H07014=1; 
SUBGROUP XTNEXREG; 
LEVELS 4; 
VAR H07015; 
 

The following program is an example of how to use SUDAAN to calculate variance estimates for 
column percentages or row percentages. Suppose you want to estimate: 

�� A cross tabulation of respondents in TNEX region 3 who last had a blood pressure reading less 
than 12 months ago, 1 to 2 years ago, and more than 2 years ago (H07049) by TRICARE 
enrollment (XENRLLMT). 

 PROC CROSSTAB DATA=HCSDB /*FILETYPE=SAS*/ DESIGN=STRWR; 
WEIGHT FWRWT; 
NEST STRATUM; 
SUBPOPN XTNEXREG = 3; 
SUBGROUP H07049 XENRLLMT; 
LEVELS 3 5; 
TABLES H07049 *XENRLLMT; 
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From the above examples, users should note that: 
 
�� PROC DESCRIPT can be used to compute estimates of means and the corresponding 

standard errors. 

�� PROC CROSSTAB can be used to compute estimates of proportions and the corresponding 
standard errors. 

For a more detailed and complete discussion of how to use SUDAAN, see Shah et al. (1997). 

Jackknife Replication Method 
 

Another popular way to estimate the variance is to use a resampling method such as jackknife 
replication, balanced repeated replication, random groups, or the bootstrap method. Like other 
replication methods, jackknife replication constructs a number of subsamples (replicates) from the full 
sample and computes the statistics of interest for each replicate (with the same formula as the full 
sample estimate). The mean square error of the replicate estimates around their corresponding full 
estimate provides an estimate of the sampling variance of the statistic of interest regardless of the 
functional form of the statistic. 

There are 60 replicate weights (FWRWT01-FWRWT60) for the Quarter II, 2007 Adult HCSDB file. 
Construction of these weights is described in the Adult Technical Manual. With the replicate weights, 
you can produce jackknife standard errors using in-house or custom written software, or you can use a 
publicly available software package such as WesVarPC or SUDAAN 7.8. Because WesVarPC 2.02 is 
available as freeware on the World Wide Web (http://www.westat.com/wesvar/demo/index.html), the 
following example explains how it is used to produce jackknife variance estimates for statistics from the 
Quarter II, 2007 Adult HCSDB.  

Suppose you want to estimate the mean rating of specialists (H07015) by beneficiaries who went to a 
specialist in the past 12 months (H07014=1) for each region (XTNEXREG). You would use WesVarPc 
as follows. 

�� Create a SAS V6.04 file, SAS Transport file, or ASCII file. WesVarPC has a restriction for the 
input data format. All files must be converted to one of these three types of files before being 
imported to WesVarPC. 

�� Create a WesVarPC data file. From the Prep menu, choose the Import Data Files screen and 
import all variables for the analysis. For this example, input H07014, H07015, and XTNEXREG 
into the Variables box, FWRWT01-FWRWT60 into the Replicates box, and MPRID into the ID 
box. Also specify the replication method as JK1 on this screen. 

�� Create a data file for the subpopulation. Specify the subpopulation by choosing the Subpop 
WesVarPC Data File from the Prep menu: H07014=1. 

�� Calculate estimates. From the Tables menu, choose New and select the file created from the 
above procedure. Then, from the Table Request screen, specify H07015 as the Analysis 
variable, MEAN (H07015) as the Compute Statistics, and XTNEXREG as the Table. 

The above steps can also be followed to produce standard errors. The WesVarPC user’s manual 
(Brick et al. 1996) provides other possible methods for producing standard errors. The latest 
WesVarPC 4.0 is no longer freeware and can be purchased from Westat.  



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II 

 
 

05/24/07  100 

PAGE IS INTENTIONALLY LEFT BLANK TO ALLOW FOR DOUBLE-SIDED COPYING 
 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II   

 

05/24/07  199 

 
POSTCELL - 
Poststratification cell for new weights 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
09001  116 0.90  6367.97 0.09  9001 
09002  110 0.85  5956.97 0.08  9002 
09003  103 0.80  6414.08 0.09  9003 
09004  7 0.05  315.00 0.00  9004 
10001  71 0.55  7405.06 0.10  10001 
10003  71 0.55  11450.32 0.16  10003 
10004  84 0.65  12295.10 0.17  10004 
10005  32 0.25  15881.84 0.22  10005 
10006  64 0.50  22994.02 0.33  10006 
10008  52 0.40  11577.67 0.16  10008 
10009  66 0.51  19782.82 0.28  10009 
10010  74 0.57  18378.83 0.26  10010 
10013  68 0.53  11790.42 0.17  10013 
10014  65 0.50  27166.85 0.38  10014 
10018  65 0.50  6030.35 0.09  10018 
10019  64 0.50  6424.49 0.09  10019 
10024  44 0.34  57697.67 0.82  10024 
10026  80 0.62  6522.84 0.09  10026 
10028  73 0.57  14999.11 0.21  10028 
10029  45 0.35  83784.97 1.19  10029 
10030  41 0.32  17684.02 0.25  10030 
10032  44 0.34  33479.51 0.47  10032 
10033  81 0.63  20632.00 0.29  10033 
10037  103 0.80  24930.55 0.35  10037 
10038  90 0.70  37124.74 0.53  10038 
10039  51 0.40  45279.80 0.64  10039 
10042  67 0.52  23759.39 0.34  10042 
10043  73 0.57  11014.25 0.16  10043 
10045  72 0.56  21188.00 0.30  10045 
10046  71 0.55  11249.32 0.16  10046 
10047  63 0.49  38181.58 0.54  10047 
10048  42 0.33  38602.37 0.55  10048 
10049  53 0.41  42154.00 0.60  10049 
10051  67 0.52  14597.00 0.21  10051 
10052  42 0.33  51324.59 0.73  10052 
10053  66 0.51  8452.00 0.12  10053 
10055  75 0.58  22506.55 0.32  10055 
10056  51 0.40  28841.85 0.41  10056 
10057  54 0.42  22941.93 0.32  10057 
10058  68 0.53  12089.21 0.17  10058 
10060  47 0.36  50306.83 0.71  10060 
10061  55 0.43  34477.97 0.49  10061 
10062  65 0.50  12998.00 0.18  10062 
10064  47 0.36  14786.49 0.21  10064 
10066  58 0.45  19314.60 0.27  10066 
10067  81 0.63  34807.32 0.49  10067 
10068  73 0.57  7862.99 0.11  10068 
10069  73 0.57  30940.21 0.44  10069 
10073  60 0.47  19370.33 0.27  10073 
10074  88 0.68  3775.05 0.05  10074 
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10075  61 0.47  20771.55 0.29  10075 
10076  63 0.49  7868.59 0.11  10076 
10077  75 0.58  7528.57 0.11  10077 
10078  88 0.68  19208.65 0.27  10078 
10079  65 0.50  28521.06 0.40  10079 
10083  70 0.54  13358.96 0.19  10083 
10086  81 0.63  11012.87 0.16  10086 
10089  52 0.40  71083.73 1.01  10089 
10091  39 0.30  56205.86 0.80  10091 
10092  52 0.40  16717.39 0.24  10092 
10094  68 0.53  8145.36 0.12  10094 
10095  70 0.54  24253.57 0.34  10095 
10096  73 0.57  18833.78 0.27  10096 
10098  54 0.42  26434.59 0.37  10098 
10101  64 0.50  11004.45 0.16  10101 
10103  60 0.47  14799.03 0.21  10103 
10104  47 0.36  17506.68 0.25  10104 
10105  45 0.35  23402.45 0.33  10105 
10108  43 0.33  32675.31 0.46  10108 
10109  68 0.53  33453.13 0.47  10109 
10110  48 0.37  78773.89 1.11  10110 
10112  53 0.41  9135.25 0.13  10112 
10113  62 0.48  9230.05 0.13  10113 
10117  54 0.42  43892.15 0.62  10117 
10118  65 0.50  13546.75 0.19  10118 
10119  79 0.61  13644.04 0.19  10119 
10120  70 0.54  21302.84 0.30  10120 
10121  65 0.50  16715.70 0.24  10121 
10122  52 0.40  12348.00 0.17  10122 
10123  93 0.72  53528.63 0.76  10123 
10124  45 0.35  68865.00 0.97  10124 
10125  48 0.37  60897.13 0.86  10125 
10126  73 0.57  25833.59 0.37  10126 
10127  62 0.48  15668.11 0.22  10127 
10128  75 0.58  9022.85 0.13  10128 
10129  60 0.47  6854.27 0.10  10129 
10131  45 0.35  8417.07 0.12  10131 
10231  82 0.64  8124.62 0.11  10231 
10248  70 0.54  6351.69 0.09  10248 
10252  74 0.57  17074.54 0.24  10252 
10280  69 0.54  19075.62 0.27  10280 
10306  79 0.61  10674.00 0.15  10306 
10310  65 0.50  6106.07 0.09  10310 
10330  33 0.26  25517.07 0.36  10330 
10364  60 0.47  4518.57 0.06  10364 
10366  88 0.68  16754.40 0.24  10366 
10378  73 0.57  13254.24 0.19  10378 
10385  81 0.63  16828.70 0.24  10385 
10387  64 0.50  17635.58 0.25  10387 
10405  55 0.43  9126.57 0.13  10405 
10407  66 0.51  10011.99 0.14  10407 
10508  93 0.72  15614.19 0.22  10508 
10606  47 0.36  31927.11 0.45  10606 
10607  48 0.37  29097.01 0.41  10607 
10609  36 0.28  27006.23 0.38  10609 
10612  53 0.41  25057.23 0.35  10612 
10620  62 0.48  8410.22 0.12  10620 
10621  67 0.52  18764.61 0.27  10621 
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10622  69 0.54  21443.73 0.30  10622 
10633  56 0.43  17029.00 0.24  10633 
10804  61 0.47  12367.00 0.18  10804 
10805  56 0.43  8935.08 0.13  10805 
10806  65 0.50  14221.99 0.20  10806 
16215  97 0.75  9214.00 0.13  16215 
17139  67 0.52  12685.40 0.18  17139 
19001  267 2.07  169767.80 2.40  19001 
19002  210 1.63  91133.77 1.29  19002 
19003  250 1.94  141725.00 2.01  19003 
19004  191 1.48  81720.50 1.16  19004 
29001  291 2.26  228452.50 3.23  29001 
29002  293 2.27  303533.50 4.30  29002 
29003  318 2.47  179577.40 2.54  29003 
29004  568 4.41  6260.68 0.09  29004 
39001  629 4.88  608103.70 8.61  39001 
39002  542 4.20  493775.70 6.99  39002 
39003  553 4.29  441909.40 6.25  39003 
39004  394 3.06  79389.59 1.12  39004 
49001  69 0.54  45247.29 0.64  49001 
49002  73 0.57  43818.05 0.62  49002 
49003  70 0.54  46158.60 0.65  49003 
49004  4 0.03  5717.00 0.08  49004 
59001  242 1.88  479072.40 6.78  59001 
59002  249 1.93  592160.20 8.38  59002 
59003  255 1.98  504105.70 7.13  59003 
59004  26 0.20  52849.00 0.75  59004 

        
 

FWRWT1 - 
Replicated/JackKnife weight 1 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.229  1319 10.23  146798.60 2.08  Minimum to 10th 

Percentile 
56.291 -- 140.225  1906 14.78  189451.80 2.68  >10th to 25th Percentile 
140.703 -- 288.301  3243 25.16  664383.70 9.40  >25th to 50th Percentile 
288.964 -- 698.503  3201 24.83  1455728.00 20.60  >50th to 75th Percentile 
701.366 -- 1240.750  1935 15.01  1899177.00 26.88  >75th to 90th Percentile 
1240.823 -- 7111.267  1288 9.99  2710134.00 38.36  >90th to 100th Percentile 
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FWRWT2 - 
Replicated/JackKnife weight 2 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.964  1305 10.12  139857.00 1.98  Minimum to 10th 

Percentile 
56.107 -- 140.455  1911 14.82  189126.90 2.68  >10th to 25th Percentile 
140.579 -- 288.518  3251 25.22  664926.20 9.41  >25th to 50th Percentile 
289.007 -- 715.152  3206 24.87  1462152.00 20.69  >50th to 75th Percentile 
715.712 -- 1247.674  1930 14.97  1893921.00 26.80  >75th to 90th Percentile 
1249.793 -- 7120.587  1289 10.00  2715690.00 38.43  >90th to 100th Percentile 

        
 

FWRWT3 - 
Replicated/JackKnife weight 3 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.864  1310 10.16  146183.60 2.07  Minimum to 10th 

Percentile 
56.064 -- 141.448  1920 14.89  190341.80 2.69  >10th to 25th Percentile 
141.522 -- 289.656  3234 25.09  662728.80 9.38  >25th to 50th Percentile 
290.128 -- 703.217  3201 24.83  1458113.00 20.64  >50th to 75th Percentile 
703.943 -- 1244.458  1939 15.04  1897900.00 26.86  >75th to 90th Percentile 
1245.544 -- 7123.480  1288 9.99  2710407.00 38.36  >90th to 100th Percentile 

        
 

FWRWT4 - 
Replicated/JackKnife weight 4 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.867  1296 10.05  147996.20 2.09  Minimum to 10th 

Percentile 
56.031 -- 141.391  1928 14.96  189700.50 2.68  >10th to 25th Percentile 
141.708 -- 288.974  3230 25.05  659986.70 9.34  >25th to 50th Percentile 
289.478 -- 712.400  3217 24.95  1464416.00 20.73  >50th to 75th Percentile 
712.773 -- 1258.926  1932 14.99  1894458.00 26.81  >75th to 90th Percentile 
1260.187 -- 7090.094  1289 10.00  2709116.00 38.34  >90th to 100th Percentile 
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FWRWT5 - 
Replicated/JackKnife weight 5 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.059  1326 10.29  154622.80 2.19  Minimum to 10th 

Percentile 
56.101 -- 140.272  1914 14.85  190160.00 2.69  >10th to 25th Percentile 
140.560 -- 289.168  3217 24.95  658321.40 9.32  >25th to 50th Percentile 
289.328 -- 709.973  3212 24.91  1458269.00 20.64  >50th to 75th Percentile 
711.085 -- 1253.129  1934 15.00  1895737.00 26.83  >75th to 90th Percentile 
1254.685 -- 7198.211  1289 10.00  2708565.00 38.33  >90th to 100th Percentile 

        
 

FWRWT6 - 
Replicated/JackKnife weight 6 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.718  1306 10.13  134549.00 1.90  Minimum to 10th 

Percentile 
56.087 -- 139.243  1892 14.68  186857.30 2.64  >10th to 25th Percentile 
139.518 -- 291.293  3259 25.28  666151.20 9.43  >25th to 50th Percentile 
291.568 -- 707.544  3212 24.91  1463801.00 20.72  >50th to 75th Percentile 
710.633 -- 1251.459  1934 15.00  1897605.00 26.86  >75th to 90th Percentile 
1253.648 -- 7141.687  1289 10.00  2716711.00 38.45  >90th to 100th Percentile 

        
 

FWRWT7 - 
Replicated/JackKnife weight 7 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.698  1323 10.26  138267.40 1.96  Minimum to 10th 

Percentile 
56.936 -- 141.438  1921 14.90  191459.70 2.71  >10th to 25th Percentile 
141.765 -- 290.268  3224 25.01  661666.40 9.36  >25th to 50th Percentile 
290.548 -- 709.372  3202 24.84  1461570.00 20.69  >50th to 75th Percentile 
710.179 -- 1263.432  1937 15.02  1903098.00 26.93  >75th to 90th Percentile 
1265.471 -- 7194.876  1285 9.97  2709613.00 38.35  >90th to 100th Percentile 
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FWRWT8 - 
Replicated/JackKnife weight 8 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.406  1296 10.05  154207.50 2.18  Minimum to 10th 

Percentile 
55.516 -- 141.236  1959 15.20  193765.00 2.74  >10th to 25th Percentile 
141.558 -- 286.666  3195 24.78  653922.90 9.25  >25th to 50th Percentile 
287.093 -- 697.220  3211 24.91  1454291.00 20.58  >50th to 75th Percentile 
697.569 -- 1251.876  1943 15.07  1897753.00 26.86  >75th to 90th Percentile 
1255.103 -- 7171.769  1288 9.99  2711734.00 38.38  >90th to 100th Percentile 

        
 

FWRWT9 - 
Replicated/JackKnife weight 9 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.173  1308 10.15  139276.70 1.97  Minimum to 10th 

Percentile 
56.356 -- 140.335  1910 14.82  189748.30 2.69  >10th to 25th Percentile 
140.663 -- 289.647  3236 25.10  662625.90 9.38  >25th to 50th Percentile 
290.186 -- 715.198  3218 24.96  1465439.00 20.74  >50th to 75th Percentile 
715.839 -- 1255.207  1933 14.99  1897228.00 26.85  >75th to 90th Percentile 
1256.792 -- 7220.115  1287 9.98  2711357.00 38.37  >90th to 100th Percentile 

        
 

FWRWT10 - 
Replicated/JackKnife weight 10 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.476  1300 10.08  158501.00 2.24  Minimum to 10th 

Percentile 
56.663 -- 140.497  1951 15.13  192725.50 2.73  >10th to 25th Percentile 
140.687 -- 288.846  3212 24.91  658195.90 9.32  >25th to 50th Percentile 
289.276 -- 700.945  3205 24.86  1457674.00 20.63  >50th to 75th Percentile 
702.588 -- 1251.135  1937 15.02  1898476.00 26.87  >75th to 90th Percentile 
1251.923 -- 7244.791  1287 9.98  2700102.00 38.21  >90th to 100th Percentile 
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FWRWT11 - 
Replicated/JackKnife weight 11 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.840  1312 10.18  142242.80 2.01  Minimum to 10th 

Percentile 
56.076 -- 140.453  1931 14.98  192221.90 2.72  >10th to 25th Percentile 
140.818 -- 288.074  3216 24.95  659597.50 9.34  >25th to 50th Percentile 
288.596 -- 710.473  3210 24.90  1460271.00 20.67  >50th to 75th Percentile 
710.895 -- 1248.550  1937 15.02  1901270.00 26.91  >75th to 90th Percentile 
1249.553 -- 7113.704  1286 9.98  2710071.00 38.36  >90th to 100th Percentile 

        
 

FWRWT12 - 
Replicated/JackKnife weight 12 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 57.193  1311 10.17  154189.40 2.18  Minimum to 10th 

Percentile 
57.384 -- 140.444  1902 14.75  188737.70 2.67  >10th to 25th Percentile 
140.507 -- 288.896  3244 25.16  664256.60 9.40  >25th to 50th Percentile 
289.366 -- 703.870  3212 24.91  1461801.00 20.69  >50th to 75th Percentile 
706.388 -- 1245.202  1935 15.01  1895145.00 26.82  >75th to 90th Percentile 
1248.921 -- 7193.670  1288 9.99  2701544.00 38.23  >90th to 100th Percentile 

        
 

FWRWT13 - 
Replicated/JackKnife weight 13 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.468  1324 10.27  153041.00 2.17  Minimum to 10th 

Percentile 
56.767 -- 141.432  1921 14.90  191476.40 2.71  >10th to 25th Percentile 
141.881 -- 287.862  3223 25.00  660989.90 9.35  >25th to 50th Percentile 
288.707 -- 712.463  3198 24.81  1453733.00 20.57  >50th to 75th Percentile 
712.812 -- 1256.142  1938 15.03  1898592.00 26.87  >75th to 90th Percentile 
1257.123 -- 7365.050  1288 9.99  2707842.00 38.32  >90th to 100th Percentile 
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FWRWT14 - 
Replicated/JackKnife weight 14 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 54.794  1299 10.08  153165.40 2.17  Minimum to 10th 

Percentile 
55.078 -- 141.364  1932 14.99  189528.80 2.68  >10th to 25th Percentile 
141.638 -- 288.746  3221 24.98  657193.60 9.30  >25th to 50th Percentile 
289.318 -- 706.665  3217 24.95  1460061.00 20.66  >50th to 75th Percentile 
709.412 -- 1256.694  1934 15.00  1894009.00 26.81  >75th to 90th Percentile 
1257.610 -- 7212.402  1289 10.00  2711716.00 38.38  >90th to 100th Percentile 

        
 

FWRWT15 - 
Replicated/JackKnife weight 15 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.043  1310 10.16  143929.70 2.04  Minimum to 10th 

Percentile 
56.169 -- 141.483  1921 14.90  190583.00 2.70  >10th to 25th Percentile 
141.925 -- 288.165  3235 25.09  662891.10 9.38  >25th to 50th Percentile 
288.455 -- 708.524  3202 24.84  1458103.00 20.64  >50th to 75th Percentile 
710.854 -- 1250.947  1936 15.02  1898251.00 26.87  >75th to 90th Percentile 
1251.614 -- 7222.266  1288 9.99  2711916.00 38.38  >90th to 100th Percentile 

        
 

FWRWT16 - 
Replicated/JackKnife weight 16 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.643  1353 10.49  132580.50 1.88  Minimum to 10th 

Percentile 
56.659 -- 140.458  1857 14.40  185972.80 2.63  >10th to 25th Percentile 
140.673 -- 289.451  3246 25.18  664591.10 9.41  >25th to 50th Percentile 
290.129 -- 718.423  3214 24.93  1465755.00 20.74  >50th to 75th Percentile 
719.300 -- 1245.293  1936 15.02  1903773.00 26.94  >75th to 90th Percentile 
1245.810 -- 7196.370  1286 9.98  2713001.00 38.40  >90th to 100th Percentile 
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FWRWT17 - 
Replicated/JackKnife weight 17 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 57.104  1356 10.52  142677.20 2.02  Minimum to 10th 

Percentile 
57.265 -- 141.372  1857 14.40  186842.30 2.64  >10th to 25th Percentile 
141.680 -- 289.367  3246 25.18  664906.90 9.41  >25th to 50th Percentile 
289.501 -- 705.499  3209 24.89  1463968.00 20.72  >50th to 75th Percentile 
706.787 -- 1252.309  1936 15.02  1901232.00 26.91  >75th to 90th Percentile 
1254.269 -- 7125.506  1288 9.99  2706048.00 38.30  >90th to 100th Percentile 

        
 

FWRWT18 - 
Replicated/JackKnife weight 18 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.157  1328 10.30  143600.80 2.03  Minimum to 10th 

Percentile 
56.484 -- 140.621  1893 14.68  187592.10 2.65  >10th to 25th Percentile 
141.508 -- 287.706  3233 25.08  661096.10 9.36  >25th to 50th Percentile 
288.048 -- 708.065  3224 25.01  1468285.00 20.78  >50th to 75th Percentile 
709.523 -- 1238.565  1927 14.95  1891394.00 26.77  >75th to 90th Percentile 
1242.292 -- 7141.173  1287 9.98  2713706.00 38.41  >90th to 100th Percentile 

        
 

FWRWT19 - 
Replicated/JackKnife weight 19 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.706  1364 10.58  144818.20 2.05  Minimum to 10th 

Percentile 
56.879 -- 140.300  1868 14.49  187804.70 2.66  >10th to 25th Percentile 
140.710 -- 288.830  3240 25.13  664292.60 9.40  >25th to 50th Percentile 
289.174 -- 702.780  3193 24.77  1454577.00 20.59  >50th to 75th Percentile 
705.776 -- 1259.952  1939 15.04  1900387.00 26.90  >75th to 90th Percentile 
1263.704 -- 7129.708  1288 9.99  2713795.00 38.41  >90th to 100th Percentile 
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FWRWT20 - 
Replicated/JackKnife weight 20 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 54.799  1297 10.06  150060.30 2.12  Minimum to 10th 

Percentile 
54.963 -- 141.480  1937 15.02  190433.50 2.70  >10th to 25th Percentile 
141.609 -- 287.538  3216 24.95  657060.40 9.30  >25th to 50th Percentile 
287.761 -- 707.474  3219 24.97  1460795.00 20.67  >50th to 75th Percentile 
710.498 -- 1235.407  1934 15.00  1894485.00 26.81  >75th to 90th Percentile 
1237.208 -- 7068.577  1289 10.00  2712840.00 38.39  >90th to 100th Percentile 

        
 

FWRWT21 - 
Replicated/JackKnife weight 21 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.203  1300 10.08  156766.10 2.22  Minimum to 10th 

Percentile 
56.466 -- 139.497  1923 14.92  189065.80 2.68  >10th to 25th Percentile 
139.537 -- 287.029  3231 25.06  658142.80 9.31  >25th to 50th Percentile 
287.537 -- 701.237  3215 24.94  1457486.00 20.63  >50th to 75th Percentile 
702.564 -- 1270.100  1934 15.00  1892516.00 26.78  >75th to 90th Percentile 
1272.353 -- 7197.730  1289 10.00  2711697.00 38.38  >90th to 100th Percentile 

        
 

FWRWT22 - 
Replicated/JackKnife weight 22 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.812  1294 10.04  141390.60 2.00  Minimum to 10th 

Percentile 
55.981 -- 140.418  1915 14.85  187811.70 2.66  >10th to 25th Percentile 
140.628 -- 288.694  3242 25.15  659734.20 9.34  >25th to 50th Percentile 
289.178 -- 709.326  3217 24.95  1461055.00 20.68  >50th to 75th Percentile 
709.749 -- 1244.384  1937 15.02  1902776.00 26.93  >75th to 90th Percentile 
1248.333 -- 7214.246  1287 9.98  2712907.00 38.40  >90th to 100th Percentile 

        
 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II   

 

05/24/07  209 

 
FWRWT23 - 
Replicated/JackKnife weight 23 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.396  1292 10.02  144695.90 2.05  Minimum to 10th 

Percentile 
55.596 -- 140.406  1943 15.07  191182.90 2.71  >10th to 25th Percentile 
140.501 -- 289.593  3212 24.91  655793.20 9.28  >25th to 50th Percentile 
290.331 -- 710.407  3224 25.01  1464058.00 20.72  >50th to 75th Percentile 
711.700 -- 1247.919  1932 14.99  1895261.00 26.82  >75th to 90th Percentile 
1248.571 -- 7066.076  1289 10.00  2714684.00 38.42  >90th to 100th Percentile 

        
 

FWRWT24 - 
Replicated/JackKnife weight 24 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.353  1295 10.04  152353.70 2.16  Minimum to 10th 

Percentile 
55.683 -- 140.251  1928 14.96  189714.20 2.69  >10th to 25th Percentile 
140.514 -- 290.753  3239 25.12  663081.00 9.38  >25th to 50th Percentile 
290.991 -- 699.770  3206 24.87  1457600.00 20.63  >50th to 75th Percentile 
703.678 -- 1248.442  1936 15.02  1897554.00 26.86  >75th to 90th Percentile 
1251.074 -- 7147.749  1288 9.99  2705371.00 38.29  >90th to 100th Percentile 

        
 

FWRWT25 - 
Replicated/JackKnife weight 25 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.463  1314 10.19  140021.30 1.98  Minimum to 10th 

Percentile 
56.897 -- 141.437  1933 14.99  192476.20 2.72  >10th to 25th Percentile 
141.536 -- 286.848  3201 24.83  655182.30 9.27  >25th to 50th Percentile 
287.259 -- 708.391  3222 24.99  1464161.00 20.72  >50th to 75th Percentile 
709.275 -- 1240.639  1933 14.99  1896643.00 26.84  >75th to 90th Percentile 
1244.810 -- 7152.618  1289 10.00  2717190.00 38.46  >90th to 100th Percentile 
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FWRWT26 - 
Replicated/JackKnife weight 26 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.992  1319 10.23  151555.50 2.14  Minimum to 10th 

Percentile 
56.014 -- 140.402  1923 14.92  190862.70 2.70  >10th to 25th Percentile 
140.582 -- 289.614  3213 24.92  656066.80 9.29  >25th to 50th Percentile 
289.872 -- 707.649  3213 24.92  1455001.00 20.59  >50th to 75th Percentile 
708.695 -- 1249.695  1935 15.01  1895826.00 26.83  >75th to 90th Percentile 
1251.606 -- 7082.438  1289 10.00  2716361.00 38.44  >90th to 100th Percentile 

        
 

FWRWT27 - 
Replicated/JackKnife weight 27 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.874  1354 10.50  138426.80 1.96  Minimum to 10th 

Percentile 
56.965 -- 140.130  1856 14.40  186281.30 2.64  >10th to 25th Percentile 
140.618 -- 289.657  3253 25.23  665538.10 9.42  >25th to 50th Percentile 
290.349 -- 712.303  3202 24.84  1460880.00 20.68  >50th to 75th Percentile 
713.656 -- 1256.506  1941 15.06  1908134.00 27.01  >75th to 90th Percentile 
1257.632 -- 6871.772  1286 9.98  2706413.00 38.30  >90th to 100th Percentile 

        
 

FWRWT28 - 
Replicated/JackKnife weight 28 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.122  1297 10.06  151204.80 2.14  Minimum to 10th 

Percentile 
55.448 -- 140.350  1936 15.02  190803.90 2.70  >10th to 25th Percentile 
140.772 -- 288.949  3229 25.05  660870.80 9.35  >25th to 50th Percentile 
289.300 -- 708.174  3208 24.88  1456780.00 20.62  >50th to 75th Percentile 
708.589 -- 1259.832  1936 15.02  1897838.00 26.86  >75th to 90th Percentile 
1260.670 -- 7092.452  1286 9.98  2708177.00 38.33  >90th to 100th Percentile 
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FWRWT29 - 
Replicated/JackKnife weight 29 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.918  1321 10.25  144902.10 2.05  Minimum to 10th 

Percentile 
56.079 -- 140.478  1919 14.89  190420.50 2.70  >10th to 25th Percentile 
140.576 -- 288.394  3222 24.99  659849.40 9.34  >25th to 50th Percentile 
288.660 -- 701.842  3207 24.88  1458536.00 20.64  >50th to 75th Percentile 
702.885 -- 1250.921  1934 15.00  1897328.00 26.85  >75th to 90th Percentile 
1259.788 -- 7236.325  1289 10.00  2714638.00 38.42  >90th to 100th Percentile 

        
 

FWRWT30 - 
Replicated/JackKnife weight 30 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.396  1294 10.04  142661.90 2.02  Minimum to 10th 

Percentile 
55.675 -- 140.355  1935 15.01  190750.80 2.70  >10th to 25th Percentile 
140.590 -- 288.515  3232 25.07  661596.00 9.36  >25th to 50th Percentile 
288.761 -- 716.255  3210 24.90  1463002.00 20.71  >50th to 75th Percentile 
717.109 -- 1256.378  1935 15.01  1898328.00 26.87  >75th to 90th Percentile 
1260.605 -- 7202.138  1286 9.98  2709336.00 38.35  >90th to 100th Percentile 

        
 

FWRWT31 - 
Replicated/JackKnife weight 31 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.548  1318 10.22  145247.20 2.06  Minimum to 10th 

Percentile 
56.922 -- 140.481  1920 14.89  191558.20 2.71  >10th to 25th Percentile 
140.813 -- 289.142  3219 24.97  660472.30 9.35  >25th to 50th Percentile 
289.255 -- 708.580  3212 24.91  1463162.00 20.71  >50th to 75th Percentile 
710.851 -- 1242.649  1935 15.01  1896676.00 26.84  >75th to 90th Percentile 
1244.763 -- 7203.466  1288 9.99  2708558.00 38.33  >90th to 100th Percentile 
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FWRWT32 - 
Replicated/JackKnife weight 32 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.042  1313 10.18  145638.70 2.06  Minimum to 10th 

Percentile 
56.390 -- 140.413  1933 14.99  191907.50 2.72  >10th to 25th Percentile 
140.629 -- 289.070  3213 24.92  658237.60 9.32  >25th to 50th Percentile 
289.572 -- 707.172  3213 24.92  1463133.00 20.71  >50th to 75th Percentile 
707.574 -- 1243.959  1931 14.98  1894242.00 26.81  >75th to 90th Percentile 
1247.245 -- 7187.613  1289 10.00  2712515.00 38.39  >90th to 100th Percentile 

        
 

FWRWT33 - 
Replicated/JackKnife weight 33 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.392  1353 10.49  142229.40 2.01  Minimum to 10th 

Percentile 
56.624 -- 140.274  1866 14.47  186889.10 2.65  >10th to 25th Percentile 
140.591 -- 289.501  3248 25.19  665020.10 9.41  >25th to 50th Percentile 
289.855 -- 703.776  3201 24.83  1459213.00 20.65  >50th to 75th Percentile 
704.702 -- 1248.515  1935 15.01  1898467.00 26.87  >75th to 90th Percentile 
1249.129 -- 7186.531  1289 10.00  2713855.00 38.41  >90th to 100th Percentile 

        
 

FWRWT34 - 
Replicated/JackKnife weight 34 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.539  1330 10.32  147286.50 2.08  Minimum to 10th 

Percentile 
56.670 -- 140.448  1884 14.61  187249.80 2.65  >10th to 25th Percentile 
140.533 -- 289.654  3235 25.09  660859.50 9.35  >25th to 50th Percentile 
290.053 -- 713.155  3225 25.02  1469116.00 20.79  >50th to 75th Percentile 
713.867 -- 1248.275  1931 14.98  1894252.00 26.81  >75th to 90th Percentile 
1249.317 -- 7157.691  1287 9.98  2706911.00 38.31  >90th to 100th Percentile 
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FWRWT35 - 
Replicated/JackKnife weight 35 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 57.256  1304 10.11  158763.40 2.25  Minimum to 10th 

Percentile 
57.497 -- 139.428  1888 14.64  184464.90 2.61  >10th to 25th Percentile 
139.557 -- 289.446  3255 25.25  661684.20 9.36  >25th to 50th Percentile 
289.961 -- 711.439  3222 24.99  1465578.00 20.74  >50th to 75th Percentile 
711.979 -- 1252.150  1934 15.00  1895150.00 26.82  >75th to 90th Percentile 
1258.590 -- 7135.845  1289 10.00  2700033.00 38.21  >90th to 100th Percentile 

        
 

FWRWT36 - 
Replicated/JackKnife weight 36 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.904  1321 10.25  142635.90 2.02  Minimum to 10th 

Percentile 
57.116 -- 141.443  1918 14.88  190698.00 2.70  >10th to 25th Percentile 
141.734 -- 287.976  3229 25.05  661869.50 9.37  >25th to 50th Percentile 
288.468 -- 708.376  3201 24.83  1456796.00 20.62  >50th to 75th Percentile 
708.856 -- 1251.342  1934 15.00  1895944.00 26.83  >75th to 90th Percentile 
1253.482 -- 7117.226  1289 10.00  2717731.00 38.46  >90th to 100th Percentile 

        
 

FWRWT37 - 
Replicated/JackKnife weight 37 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.989  1294 10.04  155883.10 2.21  Minimum to 10th 

Percentile 
56.117 -- 139.434  1911 14.82  187860.50 2.66  >10th to 25th Percentile 
139.556 -- 288.409  3247 25.19  662442.90 9.38  >25th to 50th Percentile 
288.770 -- 711.476  3221 24.98  1462586.00 20.70  >50th to 75th Percentile 
713.983 -- 1254.323  1931 14.98  1891367.00 26.77  >75th to 90th Percentile 
1256.262 -- 7257.045  1288 9.99  2705535.00 38.29  >90th to 100th Percentile 

        
 



2007 HEALTH CARE SURVEY OF DOD BENEFICIARIES – QUARTER II   

 

05/24/07  214 

 
FWRWT38 - 
Replicated/JackKnife weight 38 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.544  1319 10.23  132292.10 1.87  Minimum to 10th 

Percentile 
56.591 -- 140.306  1891 14.67  186703.10 2.64  >10th to 25th Percentile 
140.870 -- 292.117  3266 25.33  668310.40 9.46  >25th to 50th Percentile 
292.416 -- 712.306  3199 24.81  1463819.00 20.72  >50th to 75th Percentile 
713.363 -- 1250.573  1928 14.96  1895981.00 26.83  >75th to 90th Percentile 
1251.183 -- 7081.469  1289 10.00  2718568.00 38.48  >90th to 100th Percentile 

        
 

FWRWT39 - 
Replicated/JackKnife weight 39 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 54.782  1301 10.09  148008.60 2.09  Minimum to 10th 

Percentile 
55.490 -- 139.414  1917 14.87  189882.00 2.69  >10th to 25th Percentile 
139.517 -- 289.102  3244 25.16  664342.50 9.40  >25th to 50th Percentile 
289.466 -- 703.280  3205 24.86  1457258.00 20.62  >50th to 75th Percentile 
705.951 -- 1252.338  1936 15.02  1897404.00 26.85  >75th to 90th Percentile 
1253.529 -- 7193.426  1289 10.00  2708779.00 38.34  >90th to 100th Percentile 

        
 

FWRWT40 - 
Replicated/JackKnife weight 40 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.980  1320 10.24  152856.50 2.16  Minimum to 10th 

Percentile 
55.995 -- 138.451  1857 14.40  181560.90 2.57  >10th to 25th Percentile 
138.567 -- 288.934  3270 25.36  663283.70 9.39  >25th to 50th Percentile 
290.258 -- 705.256  3224 25.01  1461997.00 20.69  >50th to 75th Percentile 
707.996 -- 1262.089  1933 14.99  1893322.00 26.80  >75th to 90th Percentile 
1265.153 -- 7115.228  1288 9.99  2712654.00 38.39  >90th to 100th Percentile 
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FWRWT41 - 
Replicated/JackKnife weight 41 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.802  1295 10.04  146091.60 2.07  Minimum to 10th 

Percentile 
56.133 -- 140.385  1935 15.01  190975.30 2.70  >10th to 25th Percentile 
140.509 -- 287.083  3225 25.02  659383.80 9.33  >25th to 50th Percentile 
287.394 -- 709.643  3214 24.93  1460514.00 20.67  >50th to 75th Percentile 
712.247 -- 1259.247  1934 15.00  1895480.00 26.83  >75th to 90th Percentile 
1262.278 -- 7151.942  1289 10.00  2713229.00 38.40  >90th to 100th Percentile 

        
 

FWRWT42 - 
Replicated/JackKnife weight 42 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.349  1313 10.18  151803.10 2.15  Minimum to 10th 

Percentile 
56.498 -- 140.467  1902 14.75  189169.30 2.68  >10th to 25th Percentile 
140.758 -- 289.921  3237 25.11  661108.60 9.36  >25th to 50th Percentile 
290.261 -- 711.022  3220 24.98  1466241.00 20.75  >50th to 75th Percentile 
712.401 -- 1239.184  1934 15.00  1899288.00 26.88  >75th to 90th Percentile 
1244.776 -- 7115.721  1286 9.98  2698064.00 38.19  >90th to 100th Percentile 

        
 

FWRWT43 - 
Replicated/JackKnife weight 43 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.572  1292 10.02  142087.30 2.01  Minimum to 10th 

Percentile 
56.241 -- 141.386  1948 15.11  192718.70 2.73  >10th to 25th Percentile 
141.556 -- 290.861  3210 24.90  657415.80 9.30  >25th to 50th Percentile 
291.088 -- 705.213  3218 24.96  1462628.00 20.70  >50th to 75th Percentile 
706.868 -- 1257.366  1937 15.02  1900262.00 26.89  >75th to 90th Percentile 
1259.305 -- 7184.032  1287 9.98  2710562.00 38.36  >90th to 100th Percentile 
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FWRWT44 - 
Replicated/JackKnife weight 44 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.669  1302 10.10  143118.30 2.03  Minimum to 10th 

Percentile 
56.779 -- 140.430  1917 14.87  190787.00 2.70  >10th to 25th Percentile 
140.547 -- 287.097  3239 25.12  663765.60 9.39  >25th to 50th Percentile 
287.239 -- 707.353  3213 24.92  1464457.00 20.73  >50th to 75th Percentile 
708.469 -- 1248.159  1932 14.99  1894115.00 26.81  >75th to 90th Percentile 
1249.095 -- 7089.038  1289 10.00  2709430.00 38.35  >90th to 100th Percentile 

        
 

FWRWT45 - 
Replicated/JackKnife weight 45 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.505  1312 10.18  145144.10 2.05  Minimum to 10th 

Percentile 
56.581 -- 140.250  1914 14.85  191064.10 2.70  >10th to 25th Percentile 
140.543 -- 288.289  3223 25.00  659295.20 9.33  >25th to 50th Percentile 
288.967 -- 705.014  3221 24.98  1464206.00 20.72  >50th to 75th Percentile 
706.430 -- 1251.129  1935 15.01  1898175.00 26.86  >75th to 90th Percentile 
1252.364 -- 7120.723  1287 9.98  2707790.00 38.32  >90th to 100th Percentile 

        
 

FWRWT46 - 
Replicated/JackKnife weight 46 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.919  1317 10.22  144710.10 2.05  Minimum to 10th 

Percentile 
56.157 -- 139.479  1897 14.71  187270.20 2.65  >10th to 25th Percentile 
139.516 -- 287.780  3234 25.09  658521.70 9.32  >25th to 50th Percentile 
288.507 -- 701.782  3215 24.94  1456618.00 20.62  >50th to 75th Percentile 
702.957 -- 1248.019  1943 15.07  1904057.00 26.95  >75th to 90th Percentile 
1250.015 -- 7044.386  1286 9.98  2714497.00 38.42  >90th to 100th Percentile 
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FWRWT47 - 
Replicated/JackKnife weight 47 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.643  1294 10.04  140155.30 1.98  Minimum to 10th 

Percentile 
56.169 -- 140.309  1931 14.98  190780.60 2.70  >10th to 25th Percentile 
140.515 -- 288.980  3230 25.05  661053.30 9.36  >25th to 50th Percentile 
289.245 -- 710.319  3217 24.95  1464028.00 20.72  >50th to 75th Percentile 
711.447 -- 1252.223  1933 14.99  1895606.00 26.83  >75th to 90th Percentile 
1254.016 -- 7162.341  1287 9.98  2714051.00 38.41  >90th to 100th Percentile 

        
 

FWRWT48 - 
Replicated/JackKnife weight 48 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.056  1300 10.08  149381.70 2.11  Minimum to 10th 

Percentile 
56.151 -- 140.373  1926 14.94  188860.80 2.67  >10th to 25th Percentile 
140.543 -- 290.242  3248 25.19  663616.70 9.39  >25th to 50th Percentile 
290.751 -- 708.408  3199 24.81  1457364.00 20.63  >50th to 75th Percentile 
711.441 -- 1272.199  1930 14.97  1893285.00 26.80  >75th to 90th Percentile 
1276.256 -- 7247.708  1289 10.00  2713166.00 38.40  >90th to 100th Percentile 

        
 

FWRWT49 - 
Replicated/JackKnife weight 49 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.443  1317 10.22  154477.00 2.19  Minimum to 10th 

Percentile 
55.799 -- 141.397  1911 14.82  189284.70 2.68  >10th to 25th Percentile 
141.576 -- 290.559  3229 25.05  659482.20 9.33  >25th to 50th Percentile 
291.051 -- 705.328  3211 24.91  1457846.00 20.63  >50th to 75th Percentile 
708.604 -- 1254.554  1935 15.01  1895010.00 26.82  >75th to 90th Percentile 
1256.776 -- 7231.149  1289 10.00  2709574.00 38.35  >90th to 100th Percentile 
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FWRWT50 - 
Replicated/JackKnife weight 50 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.284  1297 10.06  132573.70 1.88  Minimum to 10th 

Percentile 
56.465 -- 141.449  1923 14.92  191530.60 2.71  >10th to 25th Percentile 
141.549 -- 287.416  3229 25.05  661845.90 9.37  >25th to 50th Percentile 
287.598 -- 713.154  3220 24.98  1468452.00 20.78  >50th to 75th Percentile 
714.032 -- 1245.580  1934 15.00  1899298.00 26.88  >75th to 90th Percentile 
1249.197 -- 7176.937  1289 10.00  2711973.00 38.38  >90th to 100th Percentile 

        
 

FWRWT51 - 
Replicated/JackKnife weight 51 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.626  1301 10.09  149046.90 2.11  Minimum to 10th 

Percentile 
55.766 -- 141.299  1927 14.95  191167.40 2.71  >10th to 25th Percentile 
141.725 -- 288.523  3233 25.08  662292.20 9.37  >25th to 50th Percentile 
288.997 -- 702.487  3211 24.91  1461269.00 20.68  >50th to 75th Percentile 
702.902 -- 1250.745  1931 14.98  1892147.00 26.78  >75th to 90th Percentile 
1252.424 -- 7139.321  1289 10.00  2709751.00 38.35  >90th to 100th Percentile 

        
 

FWRWT52 - 
Replicated/JackKnife weight 52 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.140  1307 10.14  141169.90 2.00  Minimum to 10th 

Percentile 
56.273 -- 140.403  1918 14.88  191082.00 2.70  >10th to 25th Percentile 
140.826 -- 287.930  3234 25.09  662679.90 9.38  >25th to 50th Percentile 
288.617 -- 703.986  3210 24.90  1459461.00 20.66  >50th to 75th Percentile 
707.079 -- 1257.620  1934 15.00  1894996.00 26.82  >75th to 90th Percentile 
1258.491 -- 7135.856  1289 10.00  2716285.00 38.44  >90th to 100th Percentile 
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FWRWT53 - 
Replicated/JackKnife weight 53 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.385  1296 10.05  147561.80 2.09  Minimum to 10th 

Percentile 
56.111 -- 140.405  1915 14.85  189446.90 2.68  >10th to 25th Percentile 
140.509 -- 287.311  3241 25.14  661819.80 9.37  >25th to 50th Percentile 
287.601 -- 707.429  3221 24.98  1466308.00 20.75  >50th to 75th Percentile 
713.196 -- 1247.295  1930 14.97  1892410.00 26.78  >75th to 90th Percentile 
1248.376 -- 7221.690  1289 10.00  2708128.00 38.33  >90th to 100th Percentile 

        
 

FWRWT54 - 
Replicated/JackKnife weight 54 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.565  1304 10.11  145659.80 2.06  Minimum to 10th 

Percentile 
56.790 -- 140.440  1900 14.74  187702.20 2.66  >10th to 25th Percentile 
140.627 -- 288.926  3247 25.19  663476.00 9.39  >25th to 50th Percentile 
289.416 -- 706.230  3218 24.96  1461310.00 20.68  >50th to 75th Percentile 
708.867 -- 1256.757  1936 15.02  1899218.00 26.88  >75th to 90th Percentile 
1260.410 -- 7210.569  1287 9.98  2708308.00 38.33  >90th to 100th Percentile 

        
 

FWRWT55 - 
Replicated/JackKnife weight 55 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.107  1323 10.26  147423.70 2.09  Minimum to 10th 

Percentile 
56.322 -- 140.371  1895 14.70  187018.30 2.65  >10th to 25th Percentile 
140.701 -- 287.003  3229 25.05  658075.20 9.31  >25th to 50th Percentile 
287.817 -- 709.369  3224 25.01  1465444.00 20.74  >50th to 75th Percentile 
710.091 -- 1253.299  1932 14.99  1896055.00 26.83  >75th to 90th Percentile 
1254.829 -- 7168.727  1289 10.00  2711658.00 38.38  >90th to 100th Percentile 
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FWRWT56 - 
Replicated/JackKnife weight 56 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.298  1315 10.20  131720.00 1.86  Minimum to 10th 

Percentile 
56.674 -- 139.493  1899 14.73  188516.80 2.67  >10th to 25th Percentile 
139.548 -- 290.078  3234 25.09  661252.80 9.36  >25th to 50th Percentile 
291.161 -- 713.481  3221 24.98  1467113.00 20.76  >50th to 75th Percentile 
713.899 -- 1261.675  1934 15.00  1899928.00 26.89  >75th to 90th Percentile 
1264.139 -- 7231.393  1289 10.00  2717144.00 38.46  >90th to 100th Percentile 

        
 

FWRWT57 - 
Replicated/JackKnife weight 57 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.209  1315 10.20  144241.50 2.04  Minimum to 10th 

Percentile 
56.285 -- 140.462  1895 14.70  187226.50 2.65  >10th to 25th Percentile 
140.759 -- 289.165  3239 25.12  661158.20 9.36  >25th to 50th Percentile 
289.661 -- 710.933  3219 24.97  1463892.00 20.72  >50th to 75th Percentile 
711.662 -- 1266.492  1945 15.09  1909953.00 27.03  >75th to 90th Percentile 
1270.468 -- 7208.382  1279 9.92  2699203.00 38.20  >90th to 100th Percentile 

        
 

FWRWT58 - 
Replicated/JackKnife weight 58 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.435  1291 10.01  135722.60 1.92  Minimum to 10th 

Percentile 
55.981 -- 140.428  1906 14.78  188083.80 2.66  >10th to 25th Percentile 
140.579 -- 286.920  3255 25.25  664904.80 9.41  >25th to 50th Percentile 
287.492 -- 709.495  3220 24.98  1467368.00 20.77  >50th to 75th Percentile 
709.887 -- 1263.142  1936 15.02  1899985.00 26.89  >75th to 90th Percentile 
1263.655 -- 7231.008  1284 9.96  2709610.00 38.35  >90th to 100th Percentile 
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FWRWT59 - 
Replicated/JackKnife weight 59 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 55.682  1308 10.15  144654.80 2.05  Minimum to 10th 

Percentile 
55.813 -- 140.476  1909 14.81  188417.70 2.67  >10th to 25th Percentile 
140.670 -- 289.273  3253 25.23  667459.10 9.45  >25th to 50th Percentile 
289.472 -- 707.155  3199 24.81  1457413.00 20.63  >50th to 75th Percentile 
708.215 -- 1261.951  1938 15.03  1902319.00 26.92  >75th to 90th Percentile 
1263.872 -- 7179.487  1285 9.97  2705411.00 38.29  >90th to 100th Percentile 

        
 

FWRWT60 - 
Replicated/JackKnife weight 60 

 Unweighted  Weighted   
Value Count Percent  Count Percent  Formatted Value 

        
0.000 -- 56.426  1329 10.31  143584.90 2.03  Minimum to 10th 

Percentile 
56.509 -- 141.440  1902 14.75  188462.30 2.67  >10th to 25th Percentile 
141.717 -- 290.998  3236 25.10  662524.30 9.38  >25th to 50th Percentile 
291.362 -- 700.905  3196 24.79  1453336.00 20.57  >50th to 75th Percentile 
702.583 -- 1266.446  1940 15.05  1901746.00 26.92  >75th to 90th Percentile 
1268.437 -- 7259.028  1289 10.00  2716021.00 38.44  >90th to 100th Percentile 

        
 

FWRWT - 
Final weight 

 Unweighted Weighted 
Value Count Percent  Count Percent  Formatted Value 

        
9.473 -- 66.378  1308 10.15  39740.29 0.56  Minimum to 10th 

Percentile 
66.589 -- 143.335  1945 15.09  208315.30 2.95  >10th to 25th Percentile 
143.784 -- 289.595  3215 24.94  679622.30 9.62  >25th to 50th Percentile 
289.950 -- 718.099  3205 24.86  1492920.00 21.13  >50th to 75th Percentile 
720.654 -- 1253.082  1933 14.99  1917693.00 27.14  >75th to 90th Percentile 
1254.459 -- 7053.550  1286 9.98  2727383.00 38.60  >90th to 100th Percentile 
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